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1 Introduction

The Quasonix Receiver Analyzer (RA) supports a wide range of receiver and combiner performance measurements,
including bit error rate, sync time, sync threshold, receiver latency, DQE/DQM verification, modulation index
performance, break frequency, and combiner gain, and provides multipath emulation for static and dynamic
multipath measuring. The compact 1U chassis contains two complete ARTM signal generators and eight bit error
rate testers with calibrated RF levels from -125 dBm to -10 dBm.

The two ARTM signal generators cover P, lower L, upper L, S, and C bands (200 MHz to 2500 MHz and 4.4 GHz
to 5.25 GHz contiguously), and can be configured to produce a broad array of telemetry transmit signals.

The intuitive RxAn Graphical User Interface (GUI) runs on a Windows 10 PC. The RxAn provides access to the RA
hardware via a USB interface connected to an FPGA. RxAn is closely mapped to the structure of the FPGA and
facilitates detailed control of all available functionality.

Automated scripting allows precise measurement using many parameters with rapid acquisition of extremely large
datasets. Saved results files facilitate result aggregation, analysis, presentation, and archival. Measurement results
may be exported as .csv, which can be opened in an Excel spreadsheet for flexible data analysis.

The RA is manufactured by:

Quasonix, Inc.
6025 Schumacher Park Drive
West Chester, OH 45069
CAGE code: 3CJA9

1.1 Description

This document describes the installation and operation of the Quasonix RA. The RA is designed to measure the
performance of receivers and demodulators by supplying RF test signals to the unit under test and monitoring
receiver performance via the clock and data outputs of the unit under test.

Measurements use six key parameters: Frequency (RF) range, modulation, data patterns, data rates, noise, and power
level.

The following waveform formats are supported by the RA:

e PCM/FM (ARTM Tier 0)

e SOQPSK (ARTM Tier I)

e SOQPSK-LDPC

e Multi-h CPM (ARTM Tier I)
e STC

e DPM

e Legacy (PSK) suite, which includes:

e BPSK

e QPSK

e  Offset QPSK (OQPSK)
e UQPSK
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e *AQPSK
e *AUQPSK

The eight (8) built in bit error rate testers can be used to test any clock and data outputs from any receiver or
demodulator. The only true limitation of testing the output of any receiver is maximum bit rate.

*AQPSK and AUQPSK are generated from two orthogonal BPSK-modulated bit streams.

1.2 Nomenclature
The RA is identified by the following part number:

QSX-RXAN-3R1D-A1-1111

1.3 Package Contents

The contents of the box include the following:
e RA unit
e USB 2.0 AB cable
e Power cord
e Two (2) calibrated RF output cables
e  Six (6) 75 ohm clock and data BNC cables
e (CD with control software, user manual, data sheets, etc.

Note: The very latest User Manual and Data Sheet are always available on the Quasonix web site.
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2 Specifications

Signal Generator Section

RF Outputs

2, can be slaved

Power Level

-10 dBm to —150 dBm, default range (set in 0.01 dB or finer steps)

Output RF Frequency

200.0-2500.0 MHz, tunable in 1 Hz or finer steps
4400.0-5250.0 MHz, tunable in 1 Hz or finer steps

Modulation Formats

PCM/FM, SOQPSK, MHCPM, BPSK, QPSK, OQPSK, UQPSK,
AQPSK*, AUQPSK*, DPM, STC

Bit Rates

100 bps to 46 Mbps (mode dependent) settable in 1 bps or finer steps

Data Generator Functions

Patterns: PN6, PN9, PN11, PN15, PN17, PN20, PN23, PN31, User (2 to
32 bits)

Manual error insertion
Continuous error insertion, BER 1e-9t0 0.5

Coding Options

LDPC encoding (per IRIG 106-22 Appendix 2-D)

Reed-Solomon encoding (E=16, |=1-8, per CCSDS 131.0-B-3 Section 4)
Convolutional encoding (r=1/2, K=7, per CCSDS 131.0-B-3 Section 3)
Randomization (per IRIG 106-22 and CCSDS 131.0-B-3 Sections 8, 10)
PCM encoding: NRZ-L/M/S, Bl®-L/M/S, RZ, DM-M/S, M2-M/S

Basic PCM framing (sync pattern 16 to 33 bits, minor frame up to 16384
bits, major frame up to 256 minor frames, with subframe ID insertion)

Data inversion

Signal Generator Functions

Multipath fading (settable synchronized or asynchronous phase
relationship between RF channels)

Multi-ray multipath channel emulation
Amplitude modulation
Calibrated additive white Gaussian noise

Clock and Data In/Out

TTL (BNC)

Supports one (1) input and one (1) selectable output (including
decapsulated DQE)
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Receiver Input/Status Output Section

Clock and Data In

TTL (BNC)

Supports up to eight (8) clock and data input pairs for bit error rate
testing from receivers, demodulators, etc.

Input Codes NRZ-L
TTL (HDB-15)
Status Out

BERT Error (CH1l, CH2I), Signal On/Off (CH11, CH2I), Sync Detect
(CH11, CH2l, CMBI, BSSI)

DQE Decapsulation

Automatic payload size detection

Data Sync Detection

Continuous sync time monitoring
Continuous sync loss time (i.e., latency) monitoring

Elapsed time, measured bit rate, total bits
Measured error rate, measured errors, measured errored seconds,

BERT measured link availability
Estimated error rate, estimated errors, estimated errored seconds,
estimated link availability (estimated based on DQM)
Environmental Section
Operating Temperature 0°C to +50°C
Non-operating Temperature 0°C to +70°C

Operating Humidity

0 to 95% (non-condensing)

Altitude Up to 30,000 ft.

Physical Section

Size 1U chassis; 19” wide, 1.75” tall, 14-5/16” rack depth,
15-11/16" overall depth

Weight 12.0 lbs.

Connectors — per RF Channel

RF Out: N female
Status Out: DB-15 High Density female

Connectors — per Receiver

Channel (CH1, CH2, CMB, BSS)

| Clock, Q Clock, | Data, Q Data In: BNC female

Connectors — per Chassis

TX Clock/Data In/Out: BNC female
USB-B for user interface control
AC power in

Power

25W @ 120 VAC

*AQPSK and AUQPSK are generated from two orthogonal BPSK-modulated bit streams.
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3 Installation Instructions

3.1 Mechanical

The RA’s enclosure fits in a standard 19” rack, occupying just 1U of rack space. Mechanical layouts are provided in
Figure 1 and Figure 2.
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Figure 1: Mechanical Drawing — Back View
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Figure 2: Mechanical Drawing — Top View
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3.2 Thermal

The storage temperature of the Rack Mount RA is rated for 0°C to +70°C, while the operating temperature is rated
for 0°C to +50°C. It is recommended that the unit be kept in a temperature controlled environment to minimize the
risk of operating (or storing) outside the ranges specified.

The RA features cooling vents on both sides of its aluminum chassis. These vents must be kept entirely unobstructed
in order to allow for maximum airflow through the system. Whenever feasible, it is helpful to leave an open rack
space above and below the Rack Mount RA for additional heat dissipation.

3.3 Electrical

The Rack Mount RA is available only in a dual channel configuration, with all pertinent electrical connections
located on the rear panel.

3.3.1 RA Connections

The electrical interface connector layout for the RA is shown in Figure 3. The TTL inputs are compatible with both
3.3 volt and 5 volt signals.

Figure 3: RA Back Panel

Table 1: Rear Panel Connector Specifications

Function Electrical Characteristics Connector Type
Channel 1, In-phase (l) Clock BERT Input 75 0ohm TTL 75 ohm BNC
Channel 1, In-phase (l) Data BERT Input 75 ohm TTL 75 ohm BNC
Channel 1, Quadrature (Q) Clock BERT Input 75 ohm TTL 75 ohm BNC
Channel 1, Quadrature (Q) Data BERT Input 75 0ohm TTL 75 ohm BNC
Channel 2, In-phase (l) Clock BERT Input 75 0ohm TTL 75 ohm BNC
Channel 2, In-phase (l) Data BERT Input 75 ohm TTL 75 ohm BNC
Channel 2, Quadrature (Q) Clock BERT Input 75 0ohm TTL 75 ohm BNC
Channel 2, Quadrature (Q) Data BERT Input 75 ohm TTL 75 ohm BNC
Combiner, In-phase () Clock BERT Input 75 ohm TTL 75 ohm BNC
Combiner, In-phase (l) Data BERT Input 75 0ohm TTL 75 ohm BNC
Combiner, Quadrature (Q) Clock BERT Input 75 ohm TTL 75 ohm BNC
Combiner, Quadrature (Q) Data BERT Input 75 ohm TTL 75 ohm BNC
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Function Electrical Characteristics Connector Type
BSS, In-phase (I) Clock BERT Input 75 ohm TTL 75 ohm BNC
BSS, In-phase () Data BERT Input 75 ohm TTL 75 ohm BNC
BSS, Quadrature (Q) Clock BERT Input 75 ohm TTL 75 ohm BNC
BSS, Quadrature (Q) Data BERT Input 75 ohm TTL 75 ohm BNC
Transmitter Clock In 75 ohm TTL 75 ohm BNC
Transmitter Clock Out 75 ohm TTL 75 ohm BNC
Transmitter Data In 75 ohm TTL 75 ohm BNC
Transmitter Data Out 750hm TTL 75 ohm BNC
Channel 1, Auxiliary Output 1 75 ohm TTL Ch1 DB-15, Pin 6
Channel 1, Auxiliary Output 2 75 ohm TTL Ch1 DB-15, Pin 11
Channel 1, Auxiliary Output 3 75 0hm TTL Ch1 DB-15, Pin 12
Channel 1, Auxiliary Output 4 75 ohm TTL Ch1 DB-15, Pin 13
Channel 2, Auxiliary Output 1 75 ohm TTL Ch2 DB-15, Pin 6
Channel 2, Auxiliary Output 2 75 ohm TTL Ch2 DB-15, Pin 11
Channel 2, Auxiliary Output 3 75 ohm TTL Ch2 DB-15, Pin 12
Channel 2, Auxiliary Output 4 75 0hm TTL Ch2 DB-15, Pin 13
Tx 1 RF Output 50 ohms N
Tx 2 RF Output 50 ohms N
USB Control 5V Standard USB-B
Power 90-264 V-rms AC, 47-63 Hz EAC309X

3.3.2 Digital Status Outputs

The RA digital status outputs allow the user to monitor internal status in real time. There are two female DB-15
auxiliary connectors used for this purpose. The channel 1 connector is defined as J9, while the channel 2 connector
is defined as J19, as shown in Figure 4.

J8 - Channel 1 J19 - Channel 2

Figure 4: RA Back Panel, J9 and J19 Labeled
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The female DB-15 connector pins are numbered as shown in Figure 5.

18 11

Figure 5: Female DB-15 Connector, Numbered

Table 2 describes the default status output signal parameters. These outputs can be configured for various output
status. They can optionally be configured to drive a DAC for eight (8) analog outputs. Refer to section Status
Outputs for details.

Table 2: Digital Status Output Descriptions

Signal Function | Connector | Pin Note
CH1I Error CH 1, Aux J9 6 | Bit error detected. High for every bit that is in
Output 1 error.
CH2I Error CH 2, Aux J19 6 | Bit error detected. High for every bit that is in
Output 1 error.
CH1 RF On CH 1, Aux J9 11 | High when CH1 RF enabled, low when RF
Output 2 disabled
CH2 RF On CH 2, Aux J19 11 | High when CH2 RF enabled, low when RF
Output 2 disabled
CH11 Sync Detect | CH 1, Aux J9 12 | High when CH1l synchronization detected (i.e.,
Output 3 the user-selected sync detect data pattern is
present in the receiver output data), low
otherwise
CH2I Sync Detect | CH 2, Aux J19 12 | High when CH2I synchronization detected (i.e.,
Output 3 the user-selected sync detect data pattern is
present in the receiver output data), low
otherwise
CMBI Sync Detect | CH 1, Aux J9 13 | High when CMBI synchronization detected (i.e.,
Output 4 the user-selected sync detect data pattern is
present in the receiver output data), low
otherwise
BSSI Sync Detect | CH 2, Aux J19 13 | High when BSSI synchronization detected (i.e.,
Output 4 the user-selected sync detect data pattern is
present in the receiver output data), low
otherwise
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3.4 Connect Devices

Connections between the Receiver and the RA will vary depending on the type of receiver and the measurements

desired.

1.

3.5

Connect a Receiver to the RA using the appropriate TTL clock and data cables for the receiver; connect the
RF cable from the RA to the Receiver RF input.

Connect the RA to a Windows PC using the USB connector on the back panel.

Connect each device to an appropriate power source.

Install RxAn GUI Software

The Quasonix 3™ Generation RA is shipped with an installer for the RxAn GUL

1.
2.
3.

Copy the installer software to a location on the connected PC.
Go to the software folder and locate the setup.exe file.
Double-click on the setup.exe file to start running.

Do not execute RA3Install.msi directly. Setup.exe installs any needed external requirements. It is
recommended that the default file locations be used.

RxAn uses a support library from Microsoft for the advanced math. The installer checks to see if the system
has this library installed and attempts to install it, if necessary. If your system does not have this library
installed, you will be prompted to let the installer install it, as shown in Figure 7.

Click on the Install button to continue.

¢ Rain Setup

The fodowing comporent mll be nataled om your rachine

Wigal T4+ “14" Rundima Libraries [xE4)

Do yomp wish 6 inal ol thase comporeniia 7

¥ you choces Cancel gelup el el

Figure 7: RxAn Setup, Install Components

A status window shows the progress of the installation, as shown in Figure 8.
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Figure 8: RxAn Setup, Installing Components Status

These libraries have their own installers. As each runs, you will be prompted to allow the installer to make
changes to your system. This may only be indicated by the secure desktop icon in the taskbar, as shown in
Figure 9.

Figure 9: Secure Desktop Icon

Click on the Secure icon, then select Yes to continue.

After the required library is verified as installed, the RxAn Setup Wizard displays, as shown in Figure 10.
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1 RxAn
Welcome to the RxAn Setup Wizard
QuAsonix

The inztaller will guide you through the steps required to install BxAn on pour computer.

WARMIMNG: This computer program iz protected by copyright law and international treaties.
Inauthorized duplication or distribution of thiz programm, or any portion of it may rezult in zevere civil
aor criminal penaltiez, and will be prozecuted ta the masimum extent pozzible under the law.

< Back Cancel

Figure 10: RxAn Setup Wizard Welcome Screen

4.  Click on the Next button to continue the installation.

The RxAn installation includes the matching firmware for the version of RxAn being installed. This is
located separately in case the user has difficulty with a firmware update, this can be used, under the
guidance of Quasonix, to help complete the firmware update.

While the PC location of the firmware file may be changed, it is recommended that the default file
locations be used, as shown in Figure 11.

5. Click on the Next button to continue.
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1 RxAn
RA3 Firmware

QuUASONIX

The RAZ Firmmware Falder must be located in a witable location.

Firrmware Location:
C:A\GuazonizhRAa 3 Firmware

< Back Cancel

Figure 11: RxAn Setup Wizard, Firmware Location

RxAn communicates with the RxAn hardware through a USB interface. This interface requires drivers to
be installed on the PC, if they are not already installed. To install the drivers, click on the Install Drivers?
check box, as shown in Figure 12.

If this is an update or reinstallation of RxAn, the user can uncheck the box.
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Figure 12: RxAn Setup Wizard, Install Drivers Selection

RxAn is a 64-bit executable and will be installed in the 64 bit application folder, shown in Figure 13.

7 Rean

Select Installation Folder m
QuAsonix

The ratalle vl ratall FAkliin (o the followang lolde

Too ekl i this lobday, chick. “Mest™. Tonstal boos difeent lolder, snle it balow or diick “Biowns”

Fodde

|l Wi F s one Hide Ercanse

Diigk. Ciost

sl A A dor yoursel . of for aryone who s s Sompubsr

[} E wenpons

() st e

Figure 13: RxAn Setup Wizard, Select Installation Folder
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6. Click on the Next button to continue.

When Confirm Installation displays, all of the installation options are set, and the installer is ready to begin
the installation, as shown in Figure 14.

ﬂ Raéin
Confirm Instaliation

QuAsoNIix

Vi iy hmler i 1oyl Vo riglsll M iwten oy poas Compail e

Chch. "MHeed”™ 1 st g st aladedin

Figure 14: RxAn Setup Wizard, Confirm Installation

7. Click on the Next button to start the installation.

The installation may ask if it is ok to install from an unknown source. If it does, click on the Yes button.

e 6 d v

Do you want to allow this app from an
unknown publisher to make changes to yout
deyice?

CAUserypeese N Onely ive\Deskiop\ Rele e
\FASInstall my

Figure 15: RxAn Setup Wizard, Unknown Publisher Message

While RxAn is being installed, a progress window displays, as shown in Figure 16.
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QuaAsonix
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Figure 16: RxAn Setup Wizard, Installing RxAn Status

After RxAn is installed, if the user has allowed the drivers to be installed, the Device Driver Installation
Wizard displays, as shown in Figure 17.

[esevie Diiwes Inetailetecen Whzsid
Welcome to the Device Driver

Instalation Wizard

Thiss wT] Tosipa. on ikl Ehes s ey Tl sovme

vinlreh Sell wwir] ¥ o Lo

Figure 17: Device Driver Installation Wizard Welcome Screen

8. Click on the Next button to continue the driver installation.

A License Agreement for the device driver displays, as shown in Figure 18. Select “I accept this
agreement.” You may print or save the agreement to a file, if desired.
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Figure 18: Device Driver License Agreement Acceptance

9. Click on the Next button to continue.

When the driver installation is complete, an installation status displays, as shown in Figure 19.

Compleling the Device Driver
Installation Wirard

--J- IFTARIT e TP s ATl e roE T e

B OB R DL W RROR B0 el CormDllee ] yur dewios

e i) R PacTnE S Fd] Sha [l

Figure 19: Completing the Device Driver Installation Wizard

10. Click on the Finish button to complete the driver installation.

When the RxAn installation is complete, a final status displays, as shown in Figure 20.
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Installation Complata
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Figure 20: RxAn Installation Complete

After the installation is complete, a shortcut is added to the desktop. The RxAn icon is shown in Figure 21.

Figure 21: RxAn Desktop Shortcut Icon

When the installation finishes, a shortcut to RxAn is also installed in the Windows Start Menu under a Quasonix
folder along with shortcuts to the RA3 Firmware and other RxAn Resource, including project files, layouts,
measurements, and other documentation, as shown in Figure 22.
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- Chuscoris

RA3 Firrmmmane

Figure 22: RxAn Resource Shortcuts on Start Menu

3.6 Uninstall RxAn

RxAn can be uninstalled by using either the Windows Apps & Feature settings, or by executing the original
setup.exe file.

The Welcome to RxAn Setup wizard displays, as shown in Figure 23. This lets the user repair the existing
installation or to remove RxAn.

1. Select Remove RxAn, then click on the Finish button.

_f_" Rukin
Walcome lo thae ReAn Selup Wizard
QuaAsonix

Comesct et 0w vk B repse o ssrares I il

Eeepar Hutun

81 Feegprer Axbiny

Figure 23: RxAn Setup Wizard, Repair or Remove

Quasonix, Inc.




SluAasonix
34 Generation Receiver Analyzer

2. The installation may ask if it is ok to install from an unknown source. Click on the Yes button.

A b—p.  ——-

Do you want to sllow ths upp froem an
urknown publisher to make changes 10 your
device!

CUsers s A DneDy ive\Deshaop Faloase
\RA SInstall msi

Fds G U e

Fhe 200 Fas Jran to1 $u) povgore

Figure 24: RxAn Setup Wizard, Unknown Publisher Message

A confirmation displays after RxAn is removed, as shown in Figure 25.

:ﬂ Rukin
Instalation Complata

QuAsonix

Fl o g [, o bl reraesad

Dhck, e o gedl

Figure 25: RxAn Setup Wizard, Installation (Removal) Complete

3. Click on the Close button to exit.
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3.7 Install Firmware Update

The RA hardware contains an Altera FPGA with embedded microprocessor. Each requires its own firmware to
operate the RA. RxAn requires a specific version of firmware.

Firmware updates are initiated from the Tools menu. For detailed information, refer to section 12, Appendix C.
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4 Theory of Operation

The RA consists of two channels of RF output and eight channels of receiver data analysis. The RxAn GUI provides
access to this hardware via a USB interface connected to an FPGA. The RxAn GUI is closely mapped to the
structure of the FPGA and facilitates detailed control of all available functionality.

Each of the dual RF channels consists of a Digital Baseband Signal Generator in the FPGA, Digital-to-Analog (D/A)
Converter, Synthesizer, [/Q Modulator, Amplifiers, and Step Attenuators. The channel frequencies can either be
synchronized (coherent) or different for frequency diversity simulation or adjacent channel interference testing.
Behind the scenes, the FPGA controls all RA hardware, including loading the Synthesizer frequencies, and setting
the Step Attenuators for the proper output power. Calibrated output power is achieved through digital gain control in
the FPGA.

Drivers and receivers buffer and convert the high speed clock and data signals to the appropriate FPGA operational
levels. These signals are monitored in the FPGA to measure bit rate, pattern synchronization, and both actual and
estimated bit error rate (if Data Quality Encapsulation is enabled in the receiver under test).
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Figure 26: RA System-Level Block Diagram
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Figure 27: Signal Synthesis Block Diagram
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5 Hardware and Communications Set Up

5.1 RA Front-Panel

The RA front panel contains only a power switch.

Quaso-'\x[~
- — -

—

Figure 29: RA Front Panel

5.2 RA Back Panel

A variety of connectors are located on the RA back panel, shown in Figure 30. Enlarged illustrations of the left and
right half of the back panel are shown in Figure 31 and Figure 32. Note that channel and I/Q designations are
intended to provide simple signal identification for most typical use cases, but they generally have no special
meaning in RA operation. The only functional exception is for sync time measurement (refer to section 6.4.13.2).
Therefore, for most testing, any receiver Clock/Data pair may be connected to any RA Clock/Data inputs.

Figure 30: RA Back Panel

An enlarged photo of the left half of the back panel is shown in Figure 31. It contains the following connectors:
BERT I and Q Clock and Data Input for Channel 1, Transmitter I and Q Clock and Data In/Out, Transmitter 1 RF
Output and DB-15 connector, and BERT I and Q Clock and Data Input for Channel 2.
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Figure 31: RA Back Panel, Left Side Enlarged

An enlarged photo of the right half of the back panel is shown in Figure 32. It contains the following connectors:
BERT I and Q Clock and Data Input for Best Source Selection (BSS), Transmitter 2 RF Output and DB-15
connector, BERT I and Q Clock and Data Input for Diversity Combiner, USB Control port, Power Supply port.

Figure 32: RA Back Panel, Right Side Enlarged

5.3 RA Communications Connection

Be sure the RA is connected to the PC and that the RxAn software and drivers have been installed, as described in
section 3.4 and section 3.5.

1. Go to the desktop shortcut or to the Windows Start menu.
2. Double-click on the RxAn.exe file.

The RA application scans available communication ports (COM), and automatically connects to the one
attached to the RA.

When the application opens, a box in the lower left corner of the RxAn GUI displays the COM port
connected. It displays in green when successfully connected, as shown in Figure 33.

The lower right side displays status information received from the connected RA, as shown in Figure 33.

If there is no valid COM port connection, or no status information, use the Connection option in the Main Menu
Toolbar, discussed in section 6.3.1.1, to troubleshoot the problem.

If connecting to multiple RAs, run another instance of the application after successfully connecting the first unit.
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Figure 33: RA RxAn GUI, COM Port and Status Information Circled
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6 System Operation

6.1 RA

The Quasonix RA is composed of two primary sections:

e Signal Generation
e  Measurement (Demodulated data analysis)

The signal generation section is used to create a broad variety of telemetry transmit RF signals and simulate
conditions often found after signal propagation over the air. The measurement section is used to examine data from a
receiver after demodulating the generated signals.

Each section is composed of one or more instances of functional modules. There are over 30 module types, and over
100 instances of modules. Each of these modules can be connected and configured in various ways to perform a
broad array of receiver performance measurements. This results in over 1000 configuration properties and
measurement parameters.

The RA is a powerful and flexible piece of test equipment. With that power and flexibility comes complexity. RxAn
software is the RA graphical user interface used to harness and control that power to perform a wide array of
receiver performance measurements.

Not all of the RA’s modules, properties, and parameters are required for every measurement. In some cases, only the
generated signal is needed to see if a receiver is properly configured. In other cases, only the Bit Error Rate Test
module is needed to check demodulated data from an external signal source. Sometimes complex measurements of
subtle performance differences between receivers is required.

Having a user interface that can accommodate the most complex cases would be overwhelming for the simpler
situations. The RxAn GUI is designed to be flexible and configurable, providing only what is necessary for the task
at hand and hiding unnecessary features.

Figure 34 shows an example of the Quasonix RxAn GUIL
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Figure 34: Example of Basic 3" Generation RA RxAn GUI

The RxAn GUI consists of a set of panels, with each panel representing a different function within the interface.
Panels may be displayed, hidden, moved, and arranged to suit the user.

6.2 RxAn Elements

The RxAn GUI is broken into three major regions:

e  Menu Bar
e  Status Bar

e  Main Dock

6.2.1 Menu Bar

The Menu Bar, shown in Figure 35, contains a standard Windows menu interface for lesser used operations that are
not directly related to the operation of the RA, such as opening/saving files, loading/saving layouts, connecting to
the RA, setting software options, etc. Detailed menu descriptions are provided in section 6.3.
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Figure 35: RxAn GUI, Menu Bar

6.2.2 Status Bar

The Status Bar, shown in Figure 36, contains information about the status of the RA and its connection to the RxAn
software, such as the communications port in use, the serial number of the RA attached, communication status, etc.
Detailed status and connection information is described in section 6.3.1.1.
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Figure 36: RxAn GUI, Status Bar

6.2.3 Main Dock

The Main Dock, shown in Figure 37, contains the RA control and status Tool Panel layout. This region can be tuned
for specific tasks. Tool Panels can be added, removed, positioned, and sized where it makes the most sense to the
user. After a layout has been created, it can be saved and reloaded.
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Figure 37: RxAn GUI, Main Dock

The following examples describe basic layouts included with RxAn. Each has various Tool Panels displayed in

different configurations optimized for different tasks.

Transmit Only Layout
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Figure 38:

RxAn GUI, Transmit Only Layout

Quasonix, Inc.




QuaAsonix
34 Generation Receiver Analyzer

Basic Layout

n [®

1 Ay s Bar—
| O T =B BTOFY b =B 5 AL CHE bt = B 8 EITCHE b =aw
YN CHE R T =
El: e =8 ﬂ L —— e R - g B el
TR TEE -iu' i
. Eell S 0.000E+00 O. D00DE+00 0.000E+00
| eyl |--.|H-hr-l ""' e i e s ] 1A - B gt e e A THT - DR
T e Lo i brw
b o - mim o == m F= =1 fa dm =
h:hl.-' b R -u:l.nlll _'n.h 1 M = TINER N L TNNE s ) TELEChEk BT RKE P
[T ——— [ — = —r e - = [ e — = PR S
i T L . L ] na | | " 1 m | . 1 1
L i b e b s b b - I b oo o
[T T e o] 1 fsLeE § Lol [T Fiilagged ) 108 I ERLEAE W 1l
e
@ @ = - TR J P | [ i Qi Jien
Frmd  oomed o et L 0 it T 0wt L
| LI = Em = PR i
= G O i Siw GHi
P R o o e
sl s
| i | Bk ) SR ML = BB

Figure 39: RxAn GUI, Basic Layout
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6.2.3.1 Tool Panels

Figure 40: RxAn GUI, Complete Layout

The RxAn GUI uses multiple Tool Panels. Each Tool Panel encompasses the functionality of a single module in the
RA. A Tool Panel may have controls to set properties, display status, or both.

Tool Panels exist in one of four states:

e Closed

e Floating

e Docked

e Auto Hide

Quasonix, Inc.
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6.2.3.1.1 Docked

A Tool Panel can be docked within the Main Dock. The user can place these Tool Panels in the Main Dock in
various combinations to suit the user’s needs. In this configuration, Tool Panels automatically reflow and resize,
expanding to consume the available space. The available space can be controlled by sizing the main window and by
dragging Resizing Bars between Tool Panels.

The following figures show three simple examples of RxAn, all with the same six Tool Panels docked in various
combinations in the Main Dock.
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Figure 41: RxAn GUI, Simple Docking Arrangement
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Figure 42: RxAn GUI, Docking Arrangement 2
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Figure 43: RxAn GUI, Docking Arrangement 3

Because Tool Panels automatically resize, it is possible to create a layout such that Tool Panel contents are clipped,
as shown in Figure 44. This can be corrected by resizing the main window or by dragging the Resizing Bars.

6.2.3.1.1.1

Figure 44: RxAn GUI, Tool Panel Contents Clipped

Docked Tool Panel Groups

Tool Panels may be combined into Tool Panel Groups, as shown in Figure 45. A Tool Panel Group can be moved to
a different location in the Main Dock as a single unit and will resize as a single unit when a Tool Panel Resizing Bar
for the Tool Panel Group is moved, as shown in Figure 46. For more information about resizing, refer to section

6.2.3.3.3.
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Figure 45: RxAn GUI, Tool Panel Group
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Figure 46: RxAn GUI, Tool Panel Group Moved and Resized

When panels are in a panel group, they are shown as tabs. A panel group can hold any panel type. The active panel
displays and is indicated by a white tab, with the other grouped panel tabs in grey ‘behind’ the active panel, as
shown in Figure 47; clicking on a tab moves that panel to the front of the panel group.

Quasonix, Inc.



SuaAasonix

34 Generation Receiver Analyzer

Modulatar MEDG -0 x

—

= o 0
Date Soomoe: ENCD
Moduishon - PCRMEM

Maculanon Scale |1 =t

Airink Cata Hate 59995943

Kl itaf it L 3 nchRdl W i |

Figure 47: Example Modulator Panels Docked as Tabbed

If panels are Floating, as described in the previous section, each panel displays independently on the desktop and
may be moved (dragged) to a desired location. Floating panels may also be grouped as in the Main Dock. For

example, if the same four Modulator panels are open and MODO and MOD1 are floating, MOD2 and MOD3 are
grouped.

6.2.3.1.2 Floating

A Tool Panel can be floating outside the main RxAn window. These Tool Panels can be positioned anywhere on the
screen and resized independently, as shown in Figure 48 and Figure 49.
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Figure 48: RxAn GUI, Floating Tool Panel Example 1
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Figure 49: RxAn GUI, Floating Tool Panel Example 2
6.2.3.1.2.1 Floating Tool Panel Groups

Like Docked Tool Panel Groups, floating Tool Panels may be combined into a Floating Tool Panel Group, as shown
in Figure 50, Figure 51, and Figure 52. Floating Tool Panel Groups support all of the same docking configurations

as the Main Dock.
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Figure 50: RxAn GUI, Floating Tool Panel Group Example 1
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Figure 51: RxAn GUI, Floating Tool Panel Group Example 2
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Figure 52: RxAn GUI, Floating Tool Panel Group Example 3

6.2.3.1.3 Auto Hide

Tool Panels can be set to automatically collapse to a tab against the edge of the Main Dock when not in use, as
shown in Figure 53. This makes the Tool Panel easily accessible yet takes up very little room. This can result in
extremely compact layouts.
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Figure 53: RxAn GUI, Auto Hide Tool Panel Example

Auto Hide Tool Panels can be docked to the left, right, top, and bottom of the Main Dock, as shown in Figure 54.

Figure 54: RxAn GUI, Multiple Auto Hide Tool Panel Examples

By clicking on, or hovering over, the tab of an Auto-Hide Tool Panel, it expands, making its contents accessible, as
shown in Figure 55.
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Figure 55: RxAn GUI, Unhidden Expanded Tool Panels

6.2.3.1.4 Closed

A Tool Panel that is closed is not visible on the screen, either in the Main Dock or floating. It can be opened using
the View menu and selecting the desired Tool Panel. Sometimes when a Tool Panel is shown on a complex display,
it is difficult to see where the Tool Panel is located. Holding a Shift key down while selecting the Tool Panel in the
View menu causes the Tool Panel to be opened floating in the center of the main screen.

6.2.3.2 Tool Panel Components

Each Tool Panel contains common components, as shown in Figure 56.
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Figure 56: RxAn GUI, Common Tool Panel Components

6.2.3.2.1 Title Bar

The Title Bar of a Tool Panel moves a docked Tool Panel in the layout or a floating Tool Panel on the screen.

6.2.3.2.1.1 Title

The Title of the Tool Panel is the name of the module the Tool Panel controls.

6.2.3.2.1.2 Drop Down Arrow

The drop down Arrow icon opens the drop down menu.

6.2.3.2.1.2.1 Drop Down Menu

e The Float entry causes a Docked Tool Panel to become a floating Tool Panel. It is not available in a

floating Tool Panel.

e The Dock entry causes a floating Tool Panel to become docked in the Main Dock. It is not available in a

docked Tool Panel.

e The Auto Hide entry toggles a Docked Tool Panel between its normal docked state and the Auto Hide state.

6.2.3.2.1.3 Pin/Auto Hide

The Pin/Auto-Hide icon toggles a Docked Tool Panel between its normal docked state and the Auto Hide state.

6.2.3.2.1.4 Minimize/Restore

The Minimize/Restore icon maximizes a floating Tool Panel, or restores a maximized Tool Panel to its former state.

6.2.3.2.1.5 Close

The Close icon closes the Tool Panel in both the Docked and Floating state.

Quasonix, Inc.
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6.2.3.2.2 Unit of Measure Tooltips

Units of measure are presented as tooltips in the panels. For example, when hovering over Frequency in the RF
Output panel, ‘In MHz’ displays. Similarly, hovering over AWGN in the RF Output panel, displays ‘In dB Eb/NO’.
Examples of tooltips in the RF Output CH1 panel are shown for Frequency, Power, and AWGN in Figure 57.
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Figure 57: RA On-screen ToolTips Examples

6.2.3.2.3 Border

The Tool Panel Border resizes a floating Tool Panel. Hovering over the border changes the mouse cursor to a double
headed arrow. The left/right and top/bottom borders allow changing the width/height respectively, and the four
corners allow changing both the width and height, as shown in Figure 58.
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Figure 58: RxAn GUI, Tool Panel Border Resizing

6.2.3.3 Creating and Managing Layouts

RxAn comes with three layouts of varying complexity and capability. They can be used as the basis for custom
layouts.
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6.2.3.3.1 Adding a Tool Panel
Tool Panels can be opened and closed by using the View menu on the Menu Toolbar, as shown in Figure 59.
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Figure 59: RxAn GUI, View Menu, Add a Tool Panel

The selected Tool Panel is added to the Main Dock, as shown in Figure 60.

Figure 60: RxAn GUI, Tool Panel Added to Main Dock

The Tool Panel is generally added to the same location it was in when it was last closed. When there are many Tool
Panels and Tool Panel Groups, it may be difficult to determine where the Tool Panel is located. Holding a Shift key
when opening the Tool Panel will open it in a floating state, centered over the main RxAn window, as shown in
Figure 61.
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Figure 61: RxAn GUI, Open Tool Panel in Floating State

6.2.3.3.2 Moving Tool Panels

A Tool Panel can be moved by left clicking on, and holding, the Title Bar and dragging it to a new location. As the
Tool Panel is moved, Docking Hints are displayed, as shown in Figure 62.

Figure 62: RxAn GUI, Tool Panel Docking Hints

Dragging the cursor with the Tool Panel over one of the Docking Hints displays a preview window that shows
where the Tool Panel will be docked, as shown in Figure 63.
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Figure 63: RxAn GUI, Tool Panel Docking Preview

Releasing the mouse button causes the Tool Panel to dock in that location, as shown in Figure 64.
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Figure 64: RxAn GUI, Tool Panel Docked

Left clicking with the mouse on the Title Bar of the docked Tool Panel and dragging it out of the Main Dock, leaves
it floating, as shown in Figure 65. The drop down menu options Float and Dock perform the same function.
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Figure 65: RxAn GUI, Tool Panel Floating

The four Docking Hints at the edges of the Main Dock place Tool Panels along the entire edge of the Main Dock, as

shown in Figure 66.
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Figure 66: RxAn GUI, Tool Panels Docked on Entire Edge
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The Tool Panel Docking Hint, shown in Figure 67, allows docking a Tool Panel to the top, right, left, bottom, or
with the Tool Panel the Docking Hint is covering.

Figure 67: RxAn GUI, Tool Panels Docking Hint

A Tool Panel can be docked to the left, top, right, bottom, (shown in Figure 68) or in a Tabbed Panel Group, as
shown in Figure 69.
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Figure 68: RxAn GUI, Tool Panels Docked in Different Locations
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Figure 69: RxAn GUI, Tool Panels Docked in a Tabbed Panel Group

The order of Tool Panels in a Tool Panel Group can be rearranged by left clicking on the Tool Panel tab, then
dragging it left or right, as shown in Figure 70.
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Figure 70: RxAn GUI, Tool Panels Reordering a Tabbed Panel Group

A Tabbed Panel Group can also become a Floating Panel Group, as shown in Figure. Floating Panel Groups support
all of the docking combinations as the Main Dock.
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Figure 71: RxAn GUI, Tool Panels Tabbed Panel Group to Floating Panel Group

6.2.3.3.3 Sizing Tool Panels

Docked Tool Panels can be resized by using the Resizing Bars between the Tool Panels, as shown in Figure 72.
Moving the mouse over a Resizing Bar displays the double headed arrow.

Figure 72: RxAn GUI, Sizing Tool Panels

Left clicking on the Resizing Bar displays a preview of where the Resizing Bar will have an effect, as shown in
Figure 73.
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Figure 73: RxAn GUI, Resizing Bar Locations

Dragging the Resizing Bar causes all of the Tool Panels on either side to be resized, as shown in Figure 75 and
Figure 75.
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Figure 74: RxAn GUI, Resized Tool Panels and Adjacent Panels
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Figure 75: RxAn GUI, Resizing Bar Locations

6.2.3.3.4 Example Custom Layout

Custom layouts may serve several purposes, including simplifying complex or unusual functionality, or visually
mirroring signal flow to more closely match the functional block diagram. Figure 76 depicts a combination of these.
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Figure 76: Example Basic Data Flow (AQPSK) with Associated RxAn Panels

6.2.3.4 Common Tool Panel Functionality

All Tool Panels have similar sets of functionality. Not all Tool Panels have the same functionality.

6.2.3.4.1 Property Control Sets

Sets of property controls are surrounded by a light blue border. Sets of property status displays are surrounded by a

light gray border. Both types are shown in Figure 77.
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Figure 77: RxAn GUI, Property Status and Control
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6.2.3.4.2 Numeric Up/Down (NUD) Controls

Most numeric property fields have Numeric Up/Down controls (NUDs). Numeric Up/Down controls have a Text
Field, Up/Down Buttons, and a Step Size button, as shown in Figure 78.
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Figure 78: RxAn GUI, Numeric Up/Down Controls

6.2.3.4.2.1 Text Field

A value can be entered directly into a Text Field. Hovering the mouse cursor over the numeric Text Field displays a
Tool Tip that shows the units of the property being modified, as shown in Figure 79.
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Figure 79: RxAn GUI, Tool Panel Text Field

If a value is entered that is out of range, an error message displays while the cursor is in the Text Field of the
Property Control. Moving the cursor to another Property Control leaves a red border around the Property Control to
indicate the value is invalid, as shown in Figure 80. Returning the cursor to the Property Control displays the error
message again.
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Figure 80: RxAn GUI, Invalid/Out of Range Displays

6.2.3.4.2.2 Step Up/Down

The value in the text field can be stepped up or down by using the Up/Down buttons, the up and down keyboard
arrow keys, or the mouse scroll wheel.

6.2.3.4.2.3 Step Size

The Step Size button displays the Step Size Editor, as shown in Figure 81. This sets the amount the Control Property
will change by when the Numeric Up/Down control is stepped. While there are no hard limits on the step value, step
values that exceed the range of the Control Property being stepped are not practical.
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Figure 81: RxAn GUI, Step Size Editor

The Step Size Editor will have zero or more Drop Down menus, as shown in Figure 82. These Drop Down menus
set the units for the step size, or the step type.
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Figure 82: RxAn GUI, Step Size Editor Drop Down Menus

6.2.3.4.3 Changed Property Indication

When a user makes a change to a property (Check Box, Enable Button, Numeric Field, etc.), that change is not
immediately applied to the RA hardware. It is considered a pending change. When a property has a pending change,

83.

it has a yellow background for text fields, or a yellow border for check boxes and toggle buttons, as shown in Figure

Insert Single

Pattern: |PN‘IS— _‘:_|
Rate: |'1 :—M
BER: | 1.000E-05 =

Insert Single

Insert Single

Figure 83: RxAn GUI, Changed Property Indicators

6.2.3.4.4 Pending Changes

When a user makes a change to a property (check box, Enable button, numeric field, etc.), that change is not
immediately applied to the RA hardware. It is considered a ‘pending’ change. A property has a pending change
when it has a yellow background (for text fields) or a yellow border (check boxes and toggle buttons). In the upper
right-hand corner of each Tool Panel is a set of three icons Revert, Apply, and Auto-Apply, as shown in Figure 84.

For global pending changes control, refer to the Coordinator in section 6.4.10.
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Figure 84: RxAn GUI, Change Icons

6.2.3.4.4.1 Revert

The Revert icon is enabled if there are pending changes in the Tool Panel, as shown in Figure 85. Clicking on it
reverts any changes in the Tool Panel to the state of the RA hardware.
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Figure 85: RxAn GUI, Revert Icon

6.2.3.4.4.2 Apply

The Apply icon has a red exclamation point to indicate there are pending changes that need to be applied, as shown
in Figure 86. Clicking it applies the changes in the Tool Panel to the RA hardware. The Apply icon has a green
checkmark when there are no pending changes. This only applies to the pending changes in the Tool Panel and not
others.
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Figure 86: RxAn GUI, Apply Icon

Circular Arrows/Apply Button — Used to apply changes made in the panel where the icon resides

e  When the Apply button contains a green check mark, there are no pending changes to apply, as
shown in Figure 87.

= @ ~

Figure 87: Apply Button with No Changes Pending

e When the Apply button contains a red exclamation point, as shown in Figure 88, there are pending
changes. Clicking on this icon applies any pending changes in that panel only. Pending changes in
other panels are not applied.

If there are pending changes, a Revert button displays to the left of the Apply button, also shown
in Figure 88. Clicking on the Revert button, restores the previous settings to that panel only.

B O

Figure 88: Apply Button with Pending Changes

6.2.3.4.4.3 Auto-Apply

Clicking on the Auto-Apply icon toggles the Auto-Apply state of the Tool Panel On and Off.

A green arrow in the Auto-Apply icon indicates that Auto-Apply is Off. A red pause symbol indicates that Auto-
Apply is On, as shown in Figure 89. When Auto-Apply is On, the Apply icon is disabled.
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Figure 89: RxAn GUI, Auto-Apply Icon

Gear/Auto Apply Button — Toggle button; Clicking on this button puts the panel in Auto Apply mode.
Clicking on it again, takes it out of Auto Apply mode. Any changes made to properties are automatically
applied to the RA hardware (after a short delay).

e  When a green arrow displays in the gear, as shown in Figure 90, it is not in Auto Apply mode.

e (@)

Figure 90: Gear with Green Arrow—Not in Auto Apply

e  When ared ‘pause’ symbol displays in the gear, as shown in Figure 91, Auto Apply mode is
enabled.

O]

Figure 91: Gear with Red Pause Symbol—Auto Apply Mode Enabled

e When Auto Apply mode is enabled, the Apply button is greyed out and is disabled, as shown in
Figure 92.

Figure 92: Apply Button Grey and Disabled

6.2.3.4.5 Hamburger Menu

Panels with a ‘Hamburger menu” (three lines), shown in Figure 93, display a secondary menu providing
configuration settings or the ability to perform other actions, as shown in Figure 94. These settings are generally less
frequently used and/or advanced properties.
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Figure 94: RxAn GUI, Hamburger Icon

6.2.3.4.6 Three Panel Control Group Icon

Three connected or unconnected panels indicate modules that are to be configured together; Control Groups are a
construct of the RxAn software that is used to allow multiple instances of the same module type to be configured the
same. Figure 95 shows unconnected boxes indicating that this panel is not grouped. Figure 96 shows connected
boxes and control group number 0. This indicates the panel is in control group 0, and will be configured the same as
other panels in control group 0. Control groups are discussed in detail in section 6.4.1.

Q @

Figure 95: Three Panels Icon with Unconnected Boxes

0 o

Figure 96: Three Panels Icon with Connected Boxes and Control Group Number
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6.3 RxAn Detailed Menu Descriptions

The top line of the RxAn GUI window includes a Menu Bar which provides access to common functions and
keyboard shortcuts to the functions.

6.3.1 Menu Bar

RxAn GUI has a variety of menus available on the top of the screen: File, Edit, View, Project, Connection, Options,
Tools, Window, and Help. These menus provide some common functions and keyboard shortcuts to the functions.
6.3.1.1 Connection Menu

The Connection menu, shown in Figure 97, is used to refresh the status of the connected RA, scan, locate a
communications port, display communication statistics, and set a monitor rate. Communication status information is
also provided on the bottom left and right of the RxAn, as shown in Figure 99.

| Connection | Uptions  Tools
Fatresh
Ports b
Statistics J
Mloaiitor Fake...

Figure 97: Main Menu Toolbar, Connection Menu

e  Refresh — This pulls all of the available information from the RA hardware and updates the RxAn GUI.
This happens when the RxAn.exe software is started, when the COM port is connected (or reconnected), or
when a manual refresh is performed.

A user may want/need to do this because there is no blinking yellow communication status in the right side
of the status bar at the bottom of the screen, there are unexplained pending changes, or the current
displayed configuration isn’t making sense.

e  Ports - Use the drop down menu to scan or select a communications port, as shown in Figure 98.

Cornection | Optoe=s  Tooh  Windo Help:

(mal b}

Figure 98: Connection Menu, Ports Drop Down Menu
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During the first RxAn.exe run after installation, it automatically connects to “found” RA hardware.

Each time RxAn starts after that, it attempts to reconnect to RA hardware using the port used the last time
the software was run.

e  Scan Ports — Examines all of the known communication ports on the computer and populates the list;
the known ports are scanned when RxAn.exe is started or when the user performs a manual scan. The
COM port name displays in bold text if an RA responds on that COM port.

A user may want to rescan for ports if the RA appears to be connected to a port (COM port status on
left side of the status bar at the bottom of the screen is green, as shown in Figure 99), but it doesn’t
seem to be communicating with the RA (no blinking yellow communication status in the right side of
the status bar at the bottom).

COM Port Status

Green indicates the RA has that port open. It doesn’t mean there is RA hardware on the other end of the
port. If it is red, it means the RA cannot connect to the port because it is unavailable, or the user has closed
the port. Clicking on the COM port status will close/open the port.

When the port is opened, a refresh is performed automatically. The refresh is intended to occur when there
is a possibility that the RA hardware configuration was changed outside the knowledge of the RxAn
software. For example, a user can close the port, connect to the RA hardware via terminal, make
configuration changes, open the port, and those changes will be reflected in the software.

I

Figure 99: Status Bar with COM Port and Channel Status

COM ports may have the following states:
e If the port name is grey, it is unavailable (in use somewhere else).

e Ifitis bold, it indicates RA hardware has responded to a version query indicating RA hardware is
attached to the port, as shown in Figure 98.

e If it is neither, the port is available but doesn’t appear to have RA hardware attached to it.
e Ifitis checked, it is the current port the RA is using to communicate with the RA hardware.

It is possible to have a check beside a port that is not bold because either the user selected a port that
did not appear to have RA hardware attached to it, or the port did not appear to have RA hardware
attached to it during the port scan. This can happen if the port is in use when the RxAN.exe is started
and cannot be scanned.

Clicking on a checked port will close/open the port.
Communication Status

The last two characters/boxes on the right end of the status bar indicate communication status, as
shown in Figure 100. If the box is yellow and has a number in it, it means there are messages queued
for processing. The number of messages queued is the number displayed.

The left box of the pair indicates messages coming from the RA hardware and the right box indicates
messages going fo the RA hardware. The RA hardware communicates to the RA software
autonomously, so the left box should always be blinking. If it’s not, a Connection > Refresh may
restart it.
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Figure 100: Status Bar with Serial Number, Channel Status, and Communication Status

e  Statistics — This option is a diagnostic tool primarily used by Quasonix to access communication statistics
sent between the RA hardware and the RxAn GUI. Use the drop down menu to select statistics for the
RxAn or the target RA, as shown in Figure 101.

Connection | Options Tools Window Help
Refresh
Ports *
Statistics * Rxhn
Monitor Rate... RA

Figure 101: Connection Menu, Statistics Drop Down Menu

e RxAn — Statistics the RxAn maintains, as shown in Figure 102, Connection Statistics window
e Reset Buttons — Reset specific statistics

e RA — Statistics the targeted RA hardware maintains and can send to the RxAn for display, as shown in
Figure 103, Connection Statistics - RA window

e Rate — Sets the rate the RA hardware reports communication statistics
¢ Run Button — Enables repetitive reporting of those statistics at the specified rate
e Refresh Button — Does a single poll for the statistics (when the repetitive reporting is turned off)

e Reset Button — Resets the accumulated statistics in the RA hardware
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Figure 102: Host Connection Statistics Figure 103: RA Connection Statistics

e  Monitor Rate — Use the Connection drop down menu to select Monitor Rate, as shown in Figure 104. The
Monitor Rate window, shown in Figure 105, sets the delay between reports from the RA hardware to the
RxAn GUI. It defaults to 100 ms. There should be no reason to change this unless the PC that RxAn is
running on cannot keep up with the incoming traffic from the RA hardware.

Connection | Options  Tools
Ports e baonitor Rate: 100
Statistics 8 [ Cancel | ok |
Maonitor Rate...

Figure 104: Connection, Monitor
Rate...

Figure 105: Monitor Rate Selection

6.3.1.2 Project Menu

The Project Menu in the Toolbar lets the user associate multiple files, such as window layouts, measurement scripts,
notes, etc., with a Project.

The Project drop down menu consists of four options: Add New, Add Existing, Add Current, and Remove, as shown
in Figure 106. Other files may be associated with a project. These files can be measurements (.rms), measurement
results (.rmr), notes (.txt), and window layout files (.layout), as shown in Figure 107. This is a way to associate files
with a project, so the user has quick access to them.

m Quasonix, Inc.




SluAasonix
34 Generation Receiver Analyzer

e Add New — Creates new measurement or notes file
e Add Existing — Adds an existing measurement or notes file to the project for easy access
e  Add Current — If there is a file (.rmr or .txt) currently opened in an editor, it may be added to the project.

e Remove — Removes an associated file from the project; the file is not deleted
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Figure 106: Project, Add New Drop Down Figure 107: Add New, RxAn Measurement Selection
Menu

The Project Menu is greyed out if no project is loaded.

F . Quasoniy Receiver Analyze

File Edit  View

Figure 108: Project Greyed Out

6.3.1.2.1 Project Files

Project files contain all of the RA settings in effect at the time the project file was saved, including the RxAn GUI
layout. This is particularly useful for establishing a known-good repeatable configuration for measuring or to leave a
“breadcrumb” during troubleshooting or analysis. Certain state information, such as what measurement was most
recently loaded in the Measurement panel, is not saved. Since layouts can also be saved separately, it is easy to load
a project and then to load an alternate layout if desired. There is no practical limit to the number of projects that may
be saved for later use.

The provided projects contain some settings that are required for use with the provided measurement scripts. It is
strongly advised that these projects, or projects derived from them, be used when running these measurements.
These baseline projects should never be modified.

To access a saved project, go to File>Open Project, and select from one of the available project files, as shown in
Figure 109. The specified project displays in the RxAn GUI, as shown in Figure 110.
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Figure 109: File>Open Project, Example Available Project List

A few project files are provided as possible starting points. Basic.rxan and Complete.rxan provide a single

modulated signal (PCMEM at 10 Mb/s to start) and three BERTs configured for measuring a dual-channel receiver

with combiner. The only difference between these projects is the layout: Basic.rxan uses Basic.layout, which
provides access to all common RA functions. Complete.rxan uses Complete.layout, which adds multipath capability.

For additional information about project layouts, refer to section 10, Appendix A.
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Figure 110: Example Basic.rxan Settings
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6.3.1.3 Options Menu

The Options menu, shown in Figure 111, currently provides one selection, Output > Carrier Suppression. Checked is
On, and not checked is Off.

Dpifabeis | Tools  Windew  Help

it Blw | Camies Spppression

.
LA

Figure 111: Options Output Drop Down Menu, Carrier Suppression Checked

6.3.1.3.1 Carrier Suppression

Carrier leakage is an undesired sine wave embedded within the transmitted signal at the synthesized RF carrier
frequency. It is caused by small imperfections in the analog RF modulation process. Its amplitude is generally
around 30 dB below the modulated signal, but it is present even when the signal is turned off (in other words, set to
an amplitude of 0). It acts as a form of interference and is therefore detrimental to generating an ideal modulated RF
output.

The RA mitigates carrier leakage by digitally modulating the desired signal with a center frequency offset by 20
MHz from the carrier frequency. The entire RF output is then counter-offset by the same amount, so the desired
signal is centered at the user-selected frequency and the carrier leakage appears 20 MHz away. Using this method,
the carrier leakage falls outside the band of interest for the desired signal.

Note: This method is not suitable for over-the-air transmission, as the carrier leakage and other image products
appear as interfering signals in channels adjacent to the desired signal. In this case, carrier suppression should be
disabled (not checked).

6.3.1.4 File Menu

The File menu, shown in Figure 112, provides the ability to create, open, and save RA projects. Different file types
may be created, as shown in Figure 113: Measurement (.rms), Notes (.txt), Measurement results (.rmr), and the other
related files may be viewed using the File > Open option, then selecting the desired file to open.

Mdass L [ Rl L

=i PRches

Figure 112: File Menu Figure 113: File > New Drop Down Menu
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6.3.1.5 Edit Menu

The Edit menu, shown in Figure 114, is used to cut, copy, or paste content in all editable fields. It also includes the
ability to undo an action. For example, if a user has the Channel CHO panel open, it is possible to select text from
the Frequency field, then cut, copy, or paste, using the Edit menu options or the associated shortcut keys.

el | Wiew T Coni

Figure 114: Edit Menu

6.3.1.6 View Menu

The View menu provides access to all of the configuration and status panels, as shown in Figure 115. Each of the
options provides access to a quick selection menu. Figure 116 shows the Output Channel drop down menu options.
In Figure 117, CHO and CH1 are both selected, as indicated by the checkmarks. This causes the Channel CHO and
Channel CH1 configuration panels to display, as shown in Figure 118 (and described in detail later in this manual).
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Figure 115: View Menu Figure 116: View > Output Channels Drop Down Menu
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Figure 117: View > Output Channels Drop Down Menu, Channel CHO and Channel CH1 Selected

Chasend THD = 1 X| | Dyl THT = I o

= =1 E =] .
Fraprnnys 1379 :ilnil'_l'ﬂ Figpsnzys 1237 :,.u"'l'—'-
P, - 30 e P 73 sl
ﬁ.‘.\"'ﬁl_l I"“ Rl =] AAGH _:_I'.'.:I e o e
= L= = =

| Sod | = s | = |

Figure 118: Channel CHO and Channel CH1 Configuration Screens

6.3.1.7 Tools Menu

The Tools menu is shown in Figure 119. There are six Tools selections: RA Configuration, Firmware, Calibration,
Properties, Logs, and API Server. An example of the RA Configuration drop down menu is shown in Figure 120.

T_ﬂ Window Help Tools | Window Help
RA Lonhgurahan ; ‘ RA Configuration » Reset
Firrmaars ] Firmware 3 Save
i : Calibration y Load
Properties b .
Properties »

LTE ¥

- Logs »
ARF G ¥

Figure 119: Tools Menu Figure 120: Tools > RA Configuration Drop Down Menu

e RA Configuration — These options pertain to the settings stored in the RA hardware; available options are
Reset, Save, and Load

e Reset — Loads all factory RA default parameters
e Save — Saves the current configuration to flash memory
The RA always powers on with the last saved configuration.

e Load — Loads a selected configuration from flash memory
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After a Reset or Load, the RxAn GUI is automatically updated, the same as from the RA Menu Toolbar
Connection > Refresh option.

e Firmware — The Firmware > Update option is used to update the RA 3.0 firmware. Refer to section 12,
Appendix C for detailed information about this function.

Tools | Window Help

RA Configuration L

Firmware L | Updlate
Calibration L sl
Propertias ]

Logs ]

APl Server L

Plugins ]

Figure 121: Tools > Firmware Drop Down Menu

e (Calibration — Cable Compensation, Power, and Frequency
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Figure 122: Tools > Calibration Drop Down Menu

e Cable Compensation — Compensates for losses in the cables used to connect the RA to the receiver;
this calibrates the specified output power to the end of the cable (input to the receiver) rather than the
output of the RA. This can account for using different cables, the addition of splitters, couplers, etc.

The cable calibration table is stored in the RA in two fashions. One is in volatile memory. This is the
table that is actively used when power levels are changed. If the RA is powered off, this table is lost.
The second is in non-volatile memory. This table, if present, is loaded into volatile memory at power
up.

Each RA channel can have its own cable calibration table. Each table can contain up to 317 entries.
Each entry contains the frequency and the cable loss (or gain) at that frequency. Frequencies are any
valid RA output frequency (from 200 — 2500 MHz and 4400 — 5250 MHz).

The RA has a maximum output power of -10 dBm. Any negative offset (loss) effectively takes away
from the maximum available.

1.  When the RA Cable Compensation screen opens, it is empty, as shown in Figure 123. To load a
cable compensation file, use the File drop down menu, shown in Figure 124, to select Open.
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2. Select the desired file, such as RA Cable Compensation.csv, then click on the Open button. One
cable compensation file must be loaded for each channel.

Fr 04
4 it
Frmparicy L
F . RA Cable Compensat
File R
Open
Clogza
e
Figure 123: RA Cable Compensation Figure 124: RA Cable Compensation,

File Drop Down Menu

Channel 0 Frequency and Offset values populate the RA Compensation screen, as shown in Figure
125.
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Figure 125: RA Cable Compensation with CHO Frequency and Offset Values

e  Frequency (MHz) — Frequencies measured
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e  Offset

Each channel has its own list of frequencies and offsets. The CHO tab displays the cable loss offset
for each listed frequency on Channel 0. The CHI tab shows the cable loss offset for each listed
frequency on Channel 1

3. From the RA drop down menu, shown in Figure 126, select Write.

[

Figure 126: RA Cable Compensation, RA Drop Down Menu

4. Click on the tab for Channel CH1, then repeat steps 1-3.

Read, Write, and Clear pertain to the volatile memory.
e Read — Reads the cable compensation table from the RA; This allows it to be saved to a .csv file.
e  Write — Writes the cable compensation table to the RA volatile memory

e  (Clear — Clears the calibration table from RA volatile memory; This removes all cable calibration
entries from non-volatile memory.

Save, Erase, and Load pertain to the non-volatile memory.
e Save — Saves the current cable calibration table to RA non-volatile (flash) memory

e Erase — Erases the cable calibration table stored in non-volatile memory; This means it will not be
reloaded at power on. This does not affect the currently loaded (volatile) cable calibration table.

The current cable calibration table in non-volatile must be erased before a new one can be saved.
This is a safeguard step to help prevent unintentionally overwriting the stored cable calibration
table.

o Load — Loads the cable calibration table stored in non-volatile memory into the volatile memory

If a cable calibration table has been loaded from non-volatile memory into volatile memory, either at power
on or from the Load menu entry, the indicator on the lower left side of the Status Bar should display in
green, as shown in Figure 127. This means cable compensation is active.

SN: RA-064 CH:432C CH1L:440CEE 0 0

Figure 127: RA Cable Compensation Indicator

e Power — Disabled by default; usage under advice and supervision of Quasonix support only
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e Frequency — Disabled by default; usage under advice and supervision of Quasonix support only
e  Properties — Tags and Changed

e Tags — Usage under advice and supervision of Quasonix support only

e Changed — Usage under advice and supervision of Quasonix support only

e Logs—Two types of log files may be accessed in the folder where the RA stores the files, Application and
Measurement; These would only be used if Quasonix support requested the files for troubleshooting
purposes.

i ¥ Sepi bl
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Figure 128: Tools, Logs Drop Down Menu

e  API Server — Refer to section 13, Appendix D for additional information about this function.

| Tools | Window Help
RA Configuration ]
Firmware k
Calibration J
Properties k
Logs 3
API Server v |start, |
Plugins k S::pl"}
Status

Figure 129: Tools > API Server Drop Down Menu

6.3.1.8 Window Menu

The Window menu is shown in Figure 130. The Layout selection consists of Load, Save As, and Default. The
RxAn.exe lets the user pick and choose which panels to display and their configuration at any given time. These
panel groups and their current configuration settings may be saved for future use. While a layout is part of a project
file, layouts can also be loaded and saved separately. The current window layout is saved as part of the project file.
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Figure 130: Window Menu > Layout Drop Down Menu

e Load — Loads a selected (previously saved) RxAn GUI configuration
e Save As— Saves the current configuration to a user-selected file name
e  Default — Loads the factory default layout (panels and configurations) for the RxAn GUI

When a user opens a file (File > Open) either results, or a measurement, or notes, etc. The opened file displays
in the Windows menu. Selecting that entry brings that editor to the front, as shown in Figure 131.

F Dl Ottt 3500 0 B Al
16 ae|E7
=
i_. Fuwen F [ v
r igs 1] i Do Ly
':: LR 1 i
e gy e | R | e
= B = B e ped
Torvmang ! 4 W A i e I 1
wm— i B B ity . |
1
"N e e [ ———
! ""i.;- o B Tatiem
‘I'E.."u---- at BF O | -
-_ fromctrrwer e Bl P T N ‘ll_"" i AT G bilaenk
B o i T i Bl
ieg ==
NS o Se it i i RN
| @ dcaii Dot it e T

S Ve Mesmpemgnd WWGH BT Messrermre’ mepded

| B Fr o | e Tt B S [ T B e P T A T T Tt e v B Lo

Figure 131: Window Menu > Editor Layout

6.3.1.9 Help Menu

The Help menu provides access to the user manual and RxAn version information.

The user manual for RxAn is installed as part of the application. The Help menu, Manual selection, shown in Figure
132 opens the folder containing the user manual in <install directory>\Manual. By default, that is C:\Program
Files\Quasonix\RxAn\Manual.

The Help menu, About selection, also shown in Figure 132, provides information about RxAn software and RA
firmware VERSIONS.
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The About screen provides the RA software version number and date along with the hardware versions and the
copyright statement (Figure 133).

QuaAasonix
[T
Hel ricrrid -
Manual ) e
About
W R S B TR
Figure 132: Help Menu Figure 133: About Screen

6.4 Detailed Panel Descriptions

The RxAn GUI provides panels for Channel Mixer, Data Generator, Encoder, Indirect Path, IO (Data Input and Data
Output), Modulator, Phase Generator, Phase Generator Group, Output Channels, and Summer. These panels may be
accessed via the View Menu, as described in the following sections. In addition, panels may be assigned to control
groups.

Analyzer functionality is presented in BERT Control, BERT Group, BERT Monitor, Data Sync, DQE, and
Measurement panels beginning in section 6.4.13.

6.4.1 Control Groups

The RA hardware contains various modules that can be configured. There is, generally, a panel in the RxAn GUI
that pertains to each of the different types of modules in the hardware. In many cases there are multiple instances of
those types of modules. Data Generator, Encoders, Modulators, BERTS, etc. It is common, especially for BERTs,
that the configuration of the separate instances of these modules should be configured the same. Rather than make
the user go to the panel for each instance of a module and configure it separately, instances of modules can be linked
into what is called a Control Group.

Changing the value of a property in one instance of a module in a Control Group changes the value of the property
in all of the other instances of the modules in the same control group. The user can have multiple Control Groups
made of different instances of the same type of module. For example, the user may want all of the instances of
BERTS pertaining to I data in one Control Group, and all of the instances of BERTSs pertaining to Q data in a
different Control Group.

Clicking on the Three Panel icon opens a window with a Control Group drop down menu, as shown in Figure 134.
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Figure 134: Example Data Generator Control Group Drop Down Menu

If the selection in the drop down menu is None, that module instance is not part of any Control Group. Control
Groups are identified by number, from 0 to the maximum number of Control Groups for that module type. There
will be half the number of control groups as there are instances of that module type. For BERTs there are eight (8)
BERTS, so there are four (4) Control Groups; there are 12 Phase Generators, so there are six (6) Control Groups.
This is because there must be a minimum of two modules in a Control Group for that Control group to do anything
useful, so the maximum possible number of groups is the number of modules divided by two.

If an instance of a module is in a Control Group, the Three Panel icon shows lines between them indicating it is
connected to other modules, and the Control Group ID (number) displays, as shown in Figure 135. This is so the
user can see at a glance which Control Group, if any, that instance of the module is in.

o

Figure 135: Example Data Generator Connected Three Panel Icon with Control Group 1

Not all module types can participate in a Control Group. Some do not because they are a single instance module
such as Data Input, and others, such as BERT Operation Group modules, do not because they have no properties to
set. So having them in a Control Group is meaningless.

6.42 10
The RA provides one set of input clock and data and one set of output clock and data.

The View menu provides access to the IO panels, as shown in Figure 136. Two 10 panels, Data Input and Data
Output, are used to configure IO parameters.
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6.4.2.1 Data Input

The Data Input panel is used to configure the external data input, as shown in Figure 137.

e  Clock Polarity — In a synchronous system, incoming data changes on one edge of the clock signal and is
sampled by the RA on the other edge, as shown in Figure 138. If this is incorrect, it can result in unreliable
data input. Clock polarity ensures the data is sampled on the proper clock edge.

34 Generation Receiver Analyzer
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Figure 136: View, 10 Drop Down Menu
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Figure 137: Data Input Panel
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Figure 138: Normal Clock Polarity Diagram

Valid selections are Normal, Inverted, and Auto, as shown in Figure 139.
e Normal — The RA samples data on the falling edge.
e Inverted — The RA samples data on the rising edge.

e Auto — Attempts to determine the clock edge automatically by measuring the timing between
changes in data and the changes in the clock.

e Data Polarity — Valid selections are Normal and Inverted, as shown in Figure 140; useful when the data
stream starts out inverted, in effect, un-inverts the data

Figure 139: Clock Polarity Drop Down Menu  Figure 140: Data Polarity Drop Down Menu

The Data Input panel is associated with the Data Input block in the RA signal generation section, as shown in the
diagram in Figure 141.
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Figure 141: Signal Generation, Data Input — Data Input Panel

6.4.2.2 Data Output

Data Output is the RA hardware output of clock and data. Its source can be the data input, any data generator, any
encoder, and any input to the Analyzer Section (after potential decapsulation).

The Data Output panel includes selections for Data Source, Clock Polarity, and Data Polarity, as shown in Figure
142.

Filw Edit View et Conmection Optioes  Tools

Figure 142: Data Output Panel

e Data Source — Select from data sources from Data Generators 0-3, both sub-channels for Encoders 0-3,
External, any of the eight analyzer inputs, or None, as shown in Figure 143

When EXT is selected, the external data input is routed to the data output.

e  Clock Polarity — Valid selections are Normal and Inverted, as shown in Figure 144.
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e Data Polarity —Valid selections are Normal and Inverted, as shown in Figure 144; useful when the data
stream starts out inverted, in effect, un-inverts the data

Figure 143: Data Source Drop Down Menu Figure 144: Clock Polarity and Data
Polarity Drop Down Menus

6.4.3 Status Outputs

The Receiver Analyzer supports a total of eight (8) outputs that can be used to monitor real-time status of conditions
in the Receiver Analyzer. These can be recorded with a Data Acquisition System or monitored on an oscilloscope.

They are divided into four signals each, in two connectors, J9 and J19, on the back panel, as shown in Figure 145.

J8 - Channel 1 J19 - Channel 2

Figure 145: Back Panel with J9 and J19 Labeled

The outputs can be sourced from ten signal types. Each signal type can come from one or more signal sources. The
first nine are digital in nature, and the tenth (Decapsulator DQM) is analog. An optional DAC module can be
attached to J19 to provide eight analog outputs. The DAC module uses three of the digital outputs to drive the
DAGC:s. There are three ‘classes’ of signal sources, those with no individual channel sources - None, those from the
RF output channels - CHO/CH1, and those from the input channels - CH1I/CH1Q/CH2I/... BSSI/BSSQ.
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A signal type must be placed on an appropriate output type (analog or digital) and must be matched with an
appropriate channel source.

The analog outputs are updated 200 thousand times per second and can be sourced from any signal type. If it is a
Digital signal type, the output will go from GND and Vcc on the DAC outputs.

Three of the digital outputs can be utilized to drive an optional DAC. This functionality must be enabled. When the
analog outputs are enabled, three of the output status lines (J19 P11, J19 P12, and J19 P13) are unavailable for
digital use.

Table 3: Status Outputs

Signal Type Source Channels

Fixed 0 Digital None

Fixed 1 Digital | None

RF On Digital | CHO, CH1

Signal On Digital | CHO, CH1

AM Trigger Digital | CHO, CH1

Clock Sync Digital | CH1l, CH1Q, CH2I, CH2Q, CMBI, CMBQ, BSSI, BSSQ
Data Sync Digital | CH1l, CH1Q, CH2I, CH2Q, CMBI, CMBQ, BSSI, BSSQ
Bit Error Digital | CH1l, CH1Q, CH2l, CH2Q, CMBI, CMBQ, BSSI, BSSQ
DQE Trigger Digital | CH1l, CH1Q, CH2I, CH2Q, CMBI, CMBQ, BSSI, BSSQ
DQE Lock Digital | CH1l, CH1Q, CH2I, CH2Q, CMBI, CMBQ, BSSI, BSSQ
User Digital Digital | None

DQE Metric Analog | CH1l, CH1Q, CH2I, CH2Q, CMBI, CMBQ, BSSI, BSSQ
User Analog Analog | None

e Fixed 0 always produces a low on a digital output and GND on an analog output.
e Fixed 1 always produces a high on a digital output and Vcc on an analog output.

e RF On follows the state of Channel 0 and Channel 1 RF On/Off: a low/GND for Off and a high/Vcc for
On.

e  Signal On follows the state of Channel 0 and Channel 1 Signal On/Off: a low/GND for Off and a high/Vcc
for On.

e AM Trigger follows the AM added in the Channel 0 and Channel 1 Channel Mixer AM modulation: a
low/GND when the modulation is below the average level, and a high/Vcc when the AM modulation is
above the average level. This is useful to synchronize the change in RF output level with a potential change
in signal quality from the receiver(s) under test.

e  Clock Sync follows the Clock Slip status displayed in the BERT monitors: a low/GND for clock slip and a
high/Vcc for clock sync.

Quasonix, Inc.




SluAasonix
34 Generation Receiver Analyzer

e Data Sync follows the Synced status display in the Data Sync panels. Data is synced when the user-selected
synchronization data pattern is detected in the receiver output data: a low/GND when data sync is not
detected and a high/Vcc when data sync has been detected.

e Bit Error follows the internal individual bit error detection inside the BERTSs: a low/GND with no error for
a bit and a high/Vcc when a bit is detected in error.

e DQE Trigger is toggled between low and high for every DQE frame that is decoded.

o DQE Decapsulation Lock follows the Locked status in the DQE panels: a low/GND when DQE
synchronization has not been established and a high/Vcc when DQE synchronization has been established.
This shows a single bad DQE frame.

e User Digital represents a user settable digital value. This can be set in the Status Outputs hamburger menu
or in a measurement.

e DQE Metric follows the internal DQE decapsulation and produces an analog value that matches the data
quality metric for that frame: GND for a data quality metric of 0 and Vcc for a data quality metric of
65,535.

e User Analog represents a user settable analog value. This can be set from 9 to 0.99 in the Status Outputs
hamburger menu or in a measurement.

The View menu provides access to the Status Outputs panel, as shown in Figure 146. Status Outputs are controlled
using the Status Outputs panel, shown in Figure 147.
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Figure 146: Status Outputs Drop Down Menu Figure 147: Status Outputs
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The Status Outputs panel shows the list of available outputs, the currently selected signal type, and the signal source.
Outputs highlighted in green are available for use, while outputs highlighted in yellow are not.

To enable the analog outputs for use, click on the Analog Outputs Enable check box in the Status Outputs panel
hamburger menu, as shown in Figure 148 and Figure 149.
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Figure 148: Analog Outputs Enable Check Box Figure 149: Analog Outputs Enabled

The analog outputs displays in green indicating they are available for use, and the three digital signals used to
control the optional DAC now display in yellow indicating they are no longer available for use.

If an incompatible signal source is selected for the selected signal type, the source is shown in red, and the error is
displayed in a tool tip over the incorrect channel, as shown in Figure 150.
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Figure 150: Incompatible Signal Source Error

Quasonix, Inc.



QuaAsonix
34 Generation Receiver Analyzer

When a correct channel can be selected, the error goes away. The actual Status Output signal is undefined if there is
an error.

Figure 151: Channel Selection With and Without Errors

There are two user settable Status Outputs, one digital and one analog. These are accessed in the Status Outputs
hamburger menu. The digital output is set using the Digital User Value check box (resulting in O or 1), and the
analog is set using the Analog User Value field. Type or step through a value from 0 to 0.998.
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Figure 152: Digital User Value Check Box Figure 153: Analog User Value Field

m Quasonix, Inc.



QuaAsonix
34 Generation Receiver Analyzer

6.4.4 Data Generator DG0-DG3

The Data Generator provides a known data pattern and, optionally, a known rate of random errors.

The View menu provides access to the Data Generator panels, as shown in Figure 154.
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Figure 154: View, Data Generator Drop Down Menu

The Data Generator panel, shown in Figure 155, is used to set parameters for the internal data generators. It also
includes a BER error generator.
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Figure 155: Data Generator Figure 156: Data Generator, Pattern Drop Down Menu

e Pattern — Sets the data pattern generated by the RA, as shown in Figure 156; This is a fixed pattern or a
pseudorandom pattern that repeats based on the chosen pattern/sequence (a shorter pattern looks more
regular, a longer pattern looks more random)

e PN6 - Pseudorandom pattern 2°-1 bits in length
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PN9 — Pseudorandom pattern 2°-1 bits in length

PN11 — Pseudorandom pattern 2'!'-1 bits in length
PN15 — Pseudorandom pattern 2'>-1 bits in length
PN17 — Pseudorandom pattern 2'7-1 bits in length
PN20 — Pseudorandom pattern 22°-1 bits in length
PN23 — Pseudorandom pattern 22*-1 bits in length
PN31 — Pseudorandom pattern 23'-1 bits in length

Any binary pattern between 2 and 32 bits may be typed directly into the Pattern field.

e Rate — Data rate in Mbps — Typing a number in this field sets the data rate

Step — Sets step size and unit in Hz, kHz, or MHz, as shown in Figure 157.

e Enable button — Enables or disables the data generator; disabling the data generator effectively produces an
all zeroes (0) pattern
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Figure 157: Rate, Step Selection Window

e BER - Used to add a known bit error rate to the test data stream, shown in Figure 158; type a bit error rate
to adjust the rate

Step — Sets the step size and the desired step type: Linear or Log, as shown in Figure 159.
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Figure 158: Data Generator, BER Figure 159: BER, Step Selection
Window

e  Continuous button — Continuously adds bit errors at the specified bit error rate
e Insert Single button — Click on this button to add a single bit error to the test stream

The Data Generator panel is associated with the Data Generator in the RA signal generation section, as shown in the
diagram in Figure 160.
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Figure 160: Signal Generation, Data Generator — Data Generator Panel

6.4.5 Encoder ENCO-ENC3

The Encoder panel configures the encoder module. The encoder module provides all functions necessary to convert
raw binary data in NRZ-L format to the necessary binary format for modulation. Some of these functions are
essentially standard, such as differential encoding for PSK-type modulations. Other functions are application-
specific, such as forward error correction (FEC). Many forms of encoding change the effective bit rate of the
encoded data, either by converting each bit to a di-bit such as in bi-phase encoding, or by adding header and/or
redundant bits, such as attached sync markers (ASMs) and parity bits as in low-density parity check (LDPC)
encoding. In the case of space-time coding (STC), one binary data stream is encoded into two separate orthogonal
binary data streams, each containing the original binary data information with added pilot bits.

The View menu provides access to the Encoder panel, as shown in Figure 161.

The Encoder panel, shown in Figure 162, is used to set encoding parameters. It includes data source, differential
encoding, IRIG and CCSDS randomization, block and convolutional FEC, and PCM encoding parameters.
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Figure 161: Encoder Drop Down Menu Figure 162: Encoder ENCO Panel

e Data Source — Select from data sources from Data Generators 0-3, External, or None

When EXT is selected the RA uses the external data input. If None is selected, it is as if the data and clock
are disconnected; the resulting encoded data rate will be O Mbps, and the resulting output will be an
unmodulated carrier.

o Diff Encoding — When checked, differential encoding is enabled. It is automatically enabled for *PSK
modes unless LDPC or Reed-Solomon block encoding is used

e JRIG — When checked, the IRIG randomizer is enabled (for non-LDPC operation). Enabling IRIG 15-stage
randomization ensures the pattern never has too many ones or zeroes in a row.

e CCSDS — When checked, CCSDS randomization is enabled. (for LDPC operation). Enabling
randomization ensures the pattern never has too many ones or zeroes in a row.

e Block FEC (Forward Error Correction) — ‘Block’ means bits are grouped into a block and extra information
is added to each block that the receiver can use to correct errors. The correction is done in the receiver on a
block by block basis.

Only Encoder ENCO supports block FEC. Valid selections from the drop down menu are None, R-S (Reed-
Solomon), or IRIG LDPC.

e Conv FEC — Convolutional FEC is a continuous process across the stream of bits. When checked,
convolutional encoding is enabled.

e PCM Encoding — Select the PCM Encoding value from the drop down menu, shown in Figure 163; default
setting is NRZL
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Possible settings include:

NRZ-L: Non-return-to-zero, level

NRZ-M: Non-return-to-zero, mark
NRZ-S: Non-return-to-zero, space
Biphase-S: Big, space

e DM-M: Delay modulation (Miller code), mark

e DM-S: Delay modulation (Miller code), space

34 Generation Receiver Analyzer

RZ: Return-to-zero

Biphase-L: Bi¢, level

Biphase-M: Bi¢, mark

M2-M: Modified delay modulation
(Miller squared code), mark

M2-S: Delay modified modulation
(Miller squared code), space

. B
0 J0E+(

b= 0. D =1

Figure 163: Encoder PCM Encoding Drop Down Menu

PCM Framing

Quasonix RAs can encode PCM frames as defined by IRIG 106-17 Chapter 4 and Appendix 4-A. The RA can
generate a large subset of possible frame configurations, including sync word and subframe without commutation.

Quasonix RAs can generate PCM frames using external (user) data or internal test patterns for the frame payload.
Within the RA, this functionality is referred to as the PCM Framer.

The PCM Framer supports fixed-length PCM frame generation with the following parameters:

e  Major frame length up to 256 minor frames

e  Minor frame length up to 16,384 bits

e Minor frame sync pattern 16 to 33 bits (user-selectable pattern and length)

e Optional subframe ID (SFID) insertion (word 1 position only)

The resulting PCM frame format appears as shown in Figure 164.
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Figure 164: Frame Format with SFID Insertion Enabled

*Major Frame Length = Minor Frame Maximum Length multiplied by Z

There is no mechanism to align specific sets of serial bits to Data words, and there is no mechanism to align specific
data words to a given position within the frame format. Therefore, the PCM Framer cannot generate frames with

data parameters suitable for decommutation. It can, however, be used to measure frame synchronization and link
quality via SFID verification.

Encoder Hamburger Menu

Provides access to additional parameters used to configure parameters for Reed-Solomon, LDPC, PCM Framing,

etc. The Encoder Hamburger Menu, Figure 166, is accessed via the icon on the Encoder ENCO panel, as shown in
Figure 162.

Quasonix, Inc.



QuaAsonix
34 Generation Receiver Analyzer

Enrnaer ENCD 2
—1.1] Y
i ol d [Cess Polanty: | Migrmal
Crerim Source - G RS mbwrinmen
PEEETE, | LOPC Clasis | FG
Hi
CE50S LDPC WMede | 4k Raoim 23
oo FEC: B FLM Fearsing Made | Chaabied
Lo FEC

Minios Frume Lenegise | 2048
PCH Encoaling. - SIFTL Wsor Frime Lengisy

P Framing Baesden | 1716000 110070000 ]
Cptmal Frieming Haadat: |15 Sel |

Eorw Symbal

Figure 165: Encoder ENCO Panel Figure 166: Encoder Hamburger Menu

e Data Polarity — Values are Normal or Inverted; useful when the data stream starts out inverted, in effect,
un-inverts the data; use the drop down menu to select, as shown in Figure 167

Dt Palaily: | Normal
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P Framing Hemder | 110G 1 RS 00000 ]
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Figure 167: Encoder Hamburger Menu, Data Polarity Drop Down Menu

e R-S Interleave — Controls the interleaving depth, in Reed-Solomon codewords; Maximum value of eight
(8); An interleave depth of 1 is equivalent to no interleaving.

e LDPC Class — Selects the class of LDPC encoding, either standard IRIG or CCSDS, as shown in Figure
168

Quasonix, Inc.



QuaAsonix
34 Generation Receiver Analyzer

Diatm Balarity: | Mammal
B-5 Inimrednae

LD Comer: | IRES

LORC Mode |
LLE0E
BCM Frameng Wode | CRESTRe

Ko Fraeren LSy 2T4E

Bfasor Frwmes Loty

PO Framing Hender: | 1110901 1008000 8
Cphmal Frameng Hasder 70 Bt

o Symbot |

Figure 168: Encoder Hamburger Menu, LDPC Class Drop Down Menu

e LDPC Mode — Selects an LDPC mode, as shown in Figure 169
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Figure 169: Encoder Hamburger Menu, LDPC Drop Down Menu

e PCM Framing Mode — The RA can emulate basic PCM encoder frame formatting as described in IRIG 106
Chapter 4. This capability is useful for system level measurement, such as verifying decomm lock. Valid
options are Disabled, Enabled, and Sub Frame, as shown in Figure 170.

e Disabled — The data is transmitted with no PCM frame-level formatting.
e Enabled — PCM framing per the parameters described.

e  Sub Frame — If enabled, an additional word is added to each minor frame that increments each minor
frame, from 1 up to the major frame length. Presently, the subframe ID word is always the same length
as the minor frame sync word, and it appears in the word immediately following the minor frame sync
word.
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Figure 170: Encoder Hamburger Menu, PCM Framing Mode Drop Down Menu

Minor Frame Length — Used to enter the length of the minor frame (including sync word and subframe ID
word, if enabled), up to 16384 bits

Major Frame Length — Used to enter the number of minor frames in a major frame, up to 256; This
parameter only affects the count range of the subframe ID, if enabled.

PCM Framing Header — Used to enter the frame header (user pattern), or select the IRIG standard (by
length). Minimum PCM Framing Header length is 16.

Optimal Framing Header — The ‘optimal patterns’ are a set of sync words published in IRIG 106, Chapter
4, Appendix 4-A, Table A-1. There is one optimal pattern recommended for each pattern length from 16
bits to 33 bits. Because these are generally used in the telemetry community, the RxAn provides a selection
based on length, so the user does not have to type (and possibly mis-type) the whole pattern.

Click on the Set button to display the selected frame header in the PCM Framing Header field.

Conv Symbol — The Space Network Users’ Guide (NASA 450-SNUG) defines two different methods for
generating quadrature symbols (variants of QPSK) when using convolutional encoding.

The first method is for I and Q data streams to be independently encoded. In this method, two
convolutional encoders are used, one for I data and one for Q data, as shown in Figure 171. This method is
used when Conv Symbol is NOT checked.
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Figure 171: 1 and Q Data Streams Independently Encoded

The second method is for I and Q data to be created from the G1 and G2 generators, respectively, of a single
convolutional encoder, as shown in Figure 172. In this method, only one convolutional encoder is used for both the I
and Q data. This method is used when Conv Symbol is checked.
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Figure 172: | and Q Data from Single Convolutional Encoder

The Encoder panel is associated with the Encoder block in the RA signal generation section, as shown in the
diagram in Figure 173.
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Figure 173: Signal Generation, Encoder — Encoder Panel

6.4.6 Modulator MOD0O-MOD3

The modulator takes the incoming data stream and generates a signal phase trajectory based on the modulation
mode, modulation index, and filtering.

The View menu provides access to the Modulator panel, as shown in Figure 174.

The Modulator panel, shown in Figure 175, is used to configure parameters for the base band modulator. It includes
Data Source, Modulation, Modulation Scale, an Enable button, and Airlink (over the air) Data Rate display.
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Figure 174: Modulator Drop Down Menu

e Data Source — Select from data sources from Data Generators 0-3, Encoders 0-3, External, or None, shown

in Figure 176

When EXT is selected the RA uses the external data input. If None is selected, it is as if the data and clock
are disconnected; the resulting Airlink Data Rate will be 0 Mbps, and the resulting output will be an

unmodulated carrier.

When using STC modulation, the encoder produces two separate orthogonal binary data streams, one for
“top” (pilot 0) and one for “bottom” (pilot 1). Each data stream requires a separate modulator. The outputs
from the two modulators can be summed to create single top/bottom RF output, or may be output
separately in true dual transmitter function. Only Encoder panel ENCO supports STC or STC2.
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Figure 176: Data Source Drop Down Menu
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e Modulation — Waveform modes are selected using the down arrow to access the drop down menu, as
shown in Figure 177. Available modes are:

PCM/FM (ARTM Tier 0)

e SOQPSK (ARTM Tier I)
e Multi-h CPM (ARTM Tier II)

e DPM

e STC (SOQSPK-TG STC)
e STC2 (ARTM CPM STC)

e Legacy (PSK) suite, which includes:

e BPSK

o  Offset QPSK (OQPSK)

e (QPSK
e UQPSK

]
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Figure 177: Modulation Drop Down Menu

e  Modulation Scale — The process of modulation causes a prescribed deviation of a signal in response to an
input. The input is the modulation data source. Each modulation type has a defined nominal deviation.
Modulation Scale modifies that nominal deviation either up (> 1) or down (< 1).

Step — Sets the desired Modulation Scale step, as shown in Figure 178. Modulation scale is a unitless, linear

value.

Saep: |8

Figure 178: Modulation Scale, Step Window

m Quasonix, Inc.



SluAasonix
34 Generation Receiver Analyzer

e Enable Button — Enables or disables the Modulator. If it is disabled, it doesn’t modulate, and its output is
effectively zero (0); Disabling modulation achieves Carrier only

e  Filter — This is displayed when a legacy PSK modulation (BPSK, QPSK, OQPSK, UQPSK, or DPM) is
selected. It provides control over phase trajectory shaping, with 0.0 being no shaping, and 1.0 being
maximum shaping.

e Airlink Data Rate — Effective data rate going into the modulator based on the source data rate and encoder
settings, such as LDPC, STC, etc., in Mbps
Modulator Hamburger Menu

Provides access to additional parameters used to configure modulation Phase and Gain parameters. The Modulator
Hamburger Menu, Figure 180, is accessed via the icon on the Modulator MODO panel, as shown in Figure 175.
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Figure 179: Modulator MODO Panel Figure 180: Modulator Hamburger Menu

e Phase (in degrees) — This sets the base phase offset of the modulator output. This is most commonly used
when creating an AQPSK signal by summing two BPSK signals using two different modulators. One
modulator would have a base phase offset of 90 degrees.

Step — Sets the desired step size, in degrees

e I Gain — The modulator baseband output consists of both I and Q data. I and Q gain sets the relative gain of
each, with a default of one (1) or unity. It is a unitless/scalar value. This is an advanced capability.

It may be used for UQPSK, AUQPSK, or for “basic STC” (per the same-named block diagram) which has
no other means of setting different amplitudes on the two (“top” and “bottom’) STC signals.

Step — Sets the desired step size
e  (Q Gain — Refer to I Gain

The Modulator panel is associated with the Modulation block in the RA signal generation section, as shown in the
diagram in Figure 181.
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Figure 181: Signal Generation, Modulation — Modulator Panel

6.4.7 Summer SUM0-SUM3

Modulation Summers are tied to Modulator outputs. The Summer accepts modulated signals from two separate
modulator sources and combines them into a single signal path. This is useful for combining two BPSK signals into
AQPSK or combining the top and bottom signals of STC. All modulated signals must pass through a Summer. If
modulation summing is not necessary, this is strictly a passthrough module.

Summer outputs connect to the Channel Mixer inputs through both direct and indirect paths. The direct path is
always connected and is not configurable.

The View menu provides access to the Summer panel, as shown in Figure 182.

The Summer panel, shown in Figure 183, is used to set the two source modulators. Using the drop down menu,
select from None, MODO, MOD1, MOD2, or MOD3, for each source modulator.
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Figure 182: Summer Drop Down Menu Figure 183: Summer SUMO Panel

The Summer panel is associated with the Modulation Summer block in the RA signal generation section, as shown
in the diagram in Figure 184.
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Figure 184: Signal Generation, Modulation Summer — Summer Panel

6.4.8 Indirect Path

In wireless communication, multipath is a propagation phenomenon that results in radio signals reaching the
receiving antenna by two or more paths. Causes of multipath include reflection from water bodies and terrestrial
objects such as mountains and buildings. Multipath may cause constructive or destructive interference (in other
words, fading).

Each path taken from a transmitting antenna to a receiving antenna is generally referred to as a ray. Each ray is
affected by its propagation path and may have different frequency, phase, amplitude, and time delay.

Each Indirect Path (IPATH) may have as its source a Summer output and may be used as a Channel Mixer input.
Generally speaking, the IPATH allows modifying the frequency, phase, and delay of a signal. This functionality
mirrors channel effects due to signal reflection from a surface located in the vicinity of the direct propagation path.

The most common use of this functionality is to emulate multipath, where the associated Summer output represents
the line-of-sight, or direct, path. Using a single IPATH together with the Summer output creates 2-ray multipath;
using multiple IPATHs together with the Summer output creates 3-ray and higher multipath.

Likewise, IPATHs can be used to emulate differential channel effects on the two orthogonal component signals used
in STC modulation. Here, the frequency, phase, and delay of one component signal may be varied relative to the
other. STC multipath may also be emulated using additional IPATHs.

The View menu provides access to the Indirect Path panel, as shown in Figure 185.

The Indirect Path panel, shown in Figure 186, is used to set Mode parameters, as well as those for Source,
Frequency, Phase, Delay, and Mode. A menu, accessed via the Hamburger icon, allows selection of a Phase
Generator source.
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Figure 185: Indirect Path Drop Down Menu Figure 186: Indirect Path IPATHO Panel

e Mode — Sets the operating mode for this indirect path. There are three mode options within IPATH: Off,
Static, and Dynamic.

e Off — Setting the IPATH mode to Off effectively bypasses the IPATH, resulting in a copy of its input
signal with no frequency, phase, or delay offset.

e  Static — Setting the IPATH mode to Static disables the frequency offset, resulting in a static phase and
delay offset.

e  Dynamic — Setting the IPATH mode to Dynamic enables the frequency offset, which advances the
phase at the selected rate.

e  Pause Button — In Dynamic mode, clicking on Pause sets the phase to the selected value and holds it
there.

In Dynamic mode, clicking Pause again allows the phase to advance at the selected rate.
e Source — Selects which Summer output to generate an indirect path from
Valid options are None, SUMO, SUM1, SUM2, or SUM3.
e Freq— Frequency, in Hz; In Dynamic mode, this is the rate that the phase offset advances
Step — Sets the desired step size and the step size unit (Hz, kHz, or MHz)
e Phase — The base phase offset of the indirect path
Step — Sets the desired phase step, in degrees
e Delay — The delay, in nanoseconds, of the signal through the indirect path

Step — Sets the delay step in nanoseconds or ps
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Indirect Path Hamburger Menu

e Phase Gen — Setting the phase source in the IPATH Hamburger menu is an advanced capability, explained

in the general description of Phase Generators in section 6.4.12.

The Indirect Path panel is associated with the Indirect Path block in the RA signal generation section, as shown in
the diagram in Figure 189.
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6.4.9 Channel Mixer

All modulated signals, direct and indirect, are connected to a Channel Mixer. The Channel Mixer scales, and then
combines, all signals into a single signal path. This process emulates the reception of multiple signals, whether
direct rays, reflected rays, or interfering sources at a receive antenna. That data path can then have an amplitude
offset/sweep applied to the signal, which can be used to emulate the effects of conical scan antenna tracking.

Each Channel Mixer output is directly tied to the corresponding RF Output.
The View menu provides access to the Channel Mixer panel, as shown in Figure 190.
The Channel Mixer panel, shown in Figure 191, is used to select the signal sources that make up the final output

signal and set their relative scales. A menu, accessed via the Hamburger icon, provides the ability to set parameters
for signal summing mode and amplitude modulation.
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Figure 190: Channel Mixer Drop Down Menu

Quasonix, Inc.



QuaAsonix
34 Generation Receiver Analyzer

R T A T l"ll |

ey

— 5

= 2 i
2JurTey

Figure 191: Channel Mixer CHO Panel

Channel Mixer Hamburger Menu

The Channel Mixer Hamburger menu is used to set parameters for signal summing mode and amplitude modulation,
as shown in Figure 192.
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Figure 192: Channel Mixer Hamburger Menu Figure 193: Channel Mixer, Summing Mode

Drop Down Menu

e  Summing Mode — Signal summing mode relative to output power; The Signal Summing mode affects
scaling of output signals as well as scaling of additive noise (AWGN).

e Total Power — Signals are scaled such that the final signal results in the output power set in the RF
Output panel; Selecting Total Power scales the input signals such that their sum equals the total output
power in the RF Level setting. Noise is added relative to this power. This mode is most useful for
composite signals like STC.

e Magnitude 1 — All signals are summed assuming they have an incoming relative signal level of 1.0.
This may result in a final output signal that may be higher (or clipped) or lower than the output power
set in the RF Output panel. Noise is added relative to a power level of 1.0. This mode is most useful for
multipath, so noise can be scaled relative to the direct path regardless of whether other rays add
constructively or destructively.
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e Frequency Offset Source — Selects the Phase Generator used to generate the carrier suppression offset; This
should never be changed.
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Figure 194: Frequency Offset Source Drop
Down Menu

e AM Source — Enables amplitude modulation with selection of a Phase Generator from the drop down
menu, as shown in Figure 195, or disables AM insertion by selecting None from the drop down menu.
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Figure 195: AM Source Drop Down Menu
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e AM Frequency — Sets the frequency of the amplitude modulation, in Hz, as shown in Figure 196

Step — Sets the step size, in Hz, kHz, or MHz

=9 0 o
Summing Mode | Tolsl Power =

Freguency Offset Source: | PE10 =

A Soeuree | PG2
AM Frequency: O -
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By Ratia: [0 7] ik

Figure 196: AM Frequency, Step Drop Down Menu

e AM Waveform - Sets the AM modulation waveform to either a sine or square wave, as shown in Figure
197

= {0

Summing Mode: | Total Power ~
Freguency Offset Source: | PG10 e

AM Source: | PG2 v
AM Frequency: ﬁ}—lEE
AM Wawvefarm:
AM Depth
By Index: [0 [f
By Ratio: L'EI'_-

Figure 197: AM Waveform, Drop Down Menu

e AM Depth — Sets the AM modulation index; the AM depth can be set in either a percentage or a ratio in
dB. They both set the same parameter, the AM depth. Setting one will modify the other.
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Step By Index — Sets the step size as a percentage, as shown in Figure 198.
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Figure 198: AM Depth, Step Drop Down Menu

Step By Ratio — Sets the step size as a ratio in dB, as shown in Figure 199.

Summing Mode: | Total Power *
Freguency Offset Source: | PG10 o
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AM Freguency: L@ |$ E|
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Step: |:| dB

Figure 199: AM Depth, By Ratio, Step Drop Down Menu
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The diagram shown in Figure 200, illustrates how the IPATH and Channel Mixer panels relate to the Different
Magnitude/Phase/Delay flow within the RA.

The diagram shown in Figure 201, shows the relationship of the parameters within the module to the block diagram.
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Figure 200: Example Data Flow (STC), Different Magnitude/Phase/Delay with Associated RxAn Panels
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Figure 201: Example Data Flow (STC), Relationship of Parameters Within the Module to the Diagram
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The Channel Mixer panel is associated with the Channel Mixer block in the RA signal generation section, as shown
in the diagram in Figure 202.
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Figure 202: Signal Generation, Channel Mixer— Channel Mixer Panel

6.4.10 Output

The View menu provides access to the Output > Coordinator panels, as shown in Figure 203.

6.4.10.1 Coordinator

The Coordinator controls all global pending changes. The Coordinator panel functions just like the buttons
described in section 6.2.3.4.4, except the buttons in this panel apply to all panels.
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Figure 203: View, Output Drop Down Menu

The Coordinator panel, shown in Figure 204, consists of three sections: Revert Changes button, Apply Changes
button, and Auto Apply Changes button.

e Revert Changes Button — Greyed out if there are no pending changes, yellow when changes pending;
clicking on yellow button restores previous settings

e Apply Changes Button — Grey and disabled in Auto Apply mode, red exclamation point when changes
pending, green check mark when no changes pending

e  Gear/Auto Apply Button — Enabled when red ‘pause’ symbol is present; disabled when green triangle is
present

Conriinatnr = 3 N

n |

Figure 204: Coordinator, Revert Changes and Apply Changes in Yellow

6.4.11 Output Channels
Output Channels control the conversion of the digital signal to an actual RF output signal. It sets the carrier
frequency, output power, and noise level.

The View menu provides access to the Output Channels panels, as shown in Figure 205.

The Channel CHO and Channel CH1 panels, shown in Figure 206, are used to set Frequency, Power, and AWGN
parameters. A menu, accessed via the Hamburger icon, provides the ability to select which Bit Rate is used to set the
AWGN noise level in Eb/NO and the Noise Source.
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Figure 205: View, Output Channels Drop Down Menu
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Figure 206: Channel CHO and Channel CH1

e  Frequency — Frequency, in MHz, of the RA output signal
Step — Sets the step size used by Frequency in Hz, kHz, or MHz
e Power — The power level output of the signal, in dBm, sent by the RA
Step — Sets the step size for the power level, in dBm
e AWGN - AWGN (Additive White Gaussian Noise) may be digitally added to the RF output.
e Chainlink Icon — Links the associated parameter between CHO and CH1

o RF Button — The RF button turns the entire RF output On/Off. When RF is off, the receiver being measured
has no input signal of any kind. This control is useful when measuring without added noise, such as when
using the receiver’s front end to set the noise floor.

e Signal Button — The Signal button turns the modulated signal On or Off, but it has no effect on AWGN
generated by the RA. When Signal is off, the receiver being measured has input noise x dB below the
Power level, where x is the AWGN setting in dB Eb/NO. This control is useful when measuring with added
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noise. It can also be used to output noise only at a known level by setting the Power as desired and AWGN
to 0 dB Eb/NO.

6.4.11.1 AWGN Bit Rate

True Additive White Gaussian Noise (AWGN) has theoretically infinite bandwidth and infinite noise peaks.
Practical implementation of the noise generator, however, imposes limits on bandwidth and peak noise.

Noise bandwidth is automatically adjusted based on bit rate to provide an essentially flat noise spectrum in the
bandwidth of interest. No user settings are required for proper operation.

AWGN in Eb/NO is generated relative to the bit width in the signal. When multiple bit rates are present, such as
AQPSK, this determines which of the bit rates, highest or lowest, is used as the reference.

AWGH B Hate . Highest il !
Liianeil |
=1

Figure 207: Channel CHO/CH1 Hamburger Menu, AWGN Bit Rate Drop Down Menu

6.4.11.2 Noise Source

The RA provides a pool of Noise Generators, all with equal functionality. For most purposes, the RA firmware
allocates Noise Generators as needed, and no user selection or special configuration is required. Advanced users or
complex measurement scripts may reallocate Noise Generators to specific functions as desired. However, extreme
care must be taken to ensure required standard functionality is not disturbed.

The Noise Source drop down menu is used to select from four different noise sources within the RA hardware, or
None. However, there is usually no need to change this from the default setting.

| AGN Bit Bate, | Highest

Moise Source: M2 -

=0 Mone
MGD

Figure 208: Channel CHO/CH1 Hamburger Menu, Noise Source Drop Down Menu

The Output Channels panel is associated with the RF Output block in the RA signal generation section, as shown in
the diagram in Figure 209.
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Figure 209: Signal Generation, RF Output — Channel CHO Panel

6.4.12 Phase Generator PG0-PG9

Each Phase Generator has an output that represents either a static phase (for example, 90 degrees) or time-varying
phase (for example, 10 Hz). The phase/frequency is programmable to provide automatic sweeping capability
between two settable endpoints for a fixed or infinite number of iterations. This phase/frequency can be used in a
variety of ways. Common uses include:

e Indirect Path — Phase/frequency offset for multipath ray emulation

e  Channel Mixer — AM frequency

Less common or “behind the scenes” uses include:

e  Modulator — Deterministic data rate variation or modulation phase noise
e RF Output — RF frequency offset relative to the RF synthesizer frequency

The RA provides a pool of Phase Generators, all with equal functionality. For most purposes, the RA firmware
allocates Phase Generators as needed, and no user selection or special configuration is required. Advanced users or
complex measurement scripts may reallocate Phase Generators to specific functions as desired. However, extreme
care must be taken to ensure required standard functionality is not disturbed.

Multiple Phase Generators may be placed into Operation Groups so that their initial phase can be synchronized. This
is useful for measurements like break frequency, which uses two Phase Generators of equal frequency but 180
degrees out of phase to modulate the two RF output channels.

Noise Generators can also be used as phase sources in all places where Phase Generators may be used. This may be
useful for generating random data rate or modulation phase noise, among other things.

The View menu provides access to the Phase Gen panel, as shown in Figure 210.
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The Phase Generator Panel is used to set parameters for frequency sweeping. In general, the frequency sweep begins
at a given frequency offset and starts sweeping up or down until it deviates from the center frequency by a limit
amount, at which point it starts sweeping the reverse direction. Each progression between center and limit values is
considered % of a sweep cycle. The process of sweeping between upper and lower limits continues until the selected
number of sweep cycles has completed.

The Phase Gen panel, shown in Figure 211, sets parameters for Offset, Limit, Rate, Count, Direction, Start and Stop
Position, and Mode. A menu, accessed via the Hamburger icon, provides the ability to set parameters for Frequency,
Phase, and Operation Group.

All of this is advanced capability.
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Figure 210: View, Phase Generator Drop Figure 211: Phase Generator Panel and Step Window
Down Menu

e  Offset — The Offset value may be set manually, and during a sweep it updates to indicate the current sweep
frequency offset from center.

Step — Sets the offset step size and unit (Hz, kHz, or MHz), as shown in Figure 211
e Limit — Sets the allowed deviation from the center frequency
e Rate — Sets the rate at which the frequency sweeps in both the up and down directions
e  Count — Sets the count of sweep cycles that occurs prior to sweep termination

e Mode — There are three sweep modes: Off, On, and Continuous.
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Off — Disables the frequency sweep and sets the Offset to 0.0 MHz.
On — Allows the frequency sweep to proceed for the selected number of sweep cycles
Continuous — Overrides the Count value and enables sweeping for an indefinite time

Enable Button — Alternately enables and pauses the sweep

e Direction — Selects which direction (Up/Down) the sweep will go when a sweep is restarted

e  Start Position — Selects the starting frequency offset (Upper limit/Middle/Lower limit) when a sweep is
restarted

e  Stop Position — Selects the stopping frequency offset (Upper limit/Middle/Lower limit). Any sweep pattern
with different Start and Stop Positions will run for the integer number of cycles specified, plus as many Y4
cycles as needed to terminate at the Stop Position.

e Sweeps — Displays the current number of remaining sweep cycles

e Restart Button — Resets the sweep starting frequency and sweep count

Figure 212: Phase Gen, Direction Drop Down Menu Figure 213: Phase Gen, Start Position

Drop Down Menu
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Figure 214: Phase Gen, Stop Position Figure 215: Phase Gen Hamburger Menu,
Drop Down Menu Operation Group Drop Down Menu

Phase Gen Hamburger Menu

The Hamburger menu, is used to set the base Frequency and Phase, as shown in Figure 215. These are added to the
current sweep frequency/phase and may be used to offset the sweep center frequency and/or starting phase.

e Frequency — Set the time-varying phase in Hz

Step — Sets the frequency unit and step size in Hz, kHz, or MHz
e Phase — Sets a base-phase offset in degrees

Step — Sets the phase size in degrees

e  Operation Group — Configures Phase Generators into specific groups to synchronize their phase to each
other

The Phase Gen panel is associated with the Phase Gen block in the RA signal generation section, as shown in the
diagram in Figure 216.
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Figure 216: Signal Generation, Phase Gen — Phase Gen Panel

6.4.12.1 Phase Generator Operation Group Panel

Operation Groups are a RA hardware construct that the RA hardware uses to coordinate the operation of multiple
instances of the same module type. For example, Phase Generators can be configured to synchronize their phase to
each other. Note, this differs from Control Groups, which are an RxAn software construct that allows multiple
instances to be configured identically through the GUI (refer to section 6.4.1).

The View menu provides access to the Phase Gen Operation Group panels, as shown in Figure 217.

The Phase Gen Operation Group panel, shown in Figure 218, is used to enable all phase generators in the Operation
Group and to resynchronize their phase.

e Enable Check Box — Enables all of the phase generators in the Operation Group
e Resync Button — Resynchronizes the phase of all of the phase generators in the Operation Group

e  Group Members — A list of phase generators that have been assigned to this Operation Group via the Phase
Generator control panel Hamburger menu Operation Group parameter

IZAl  Quasonix, Inc.
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Figure 217: View, Phase Generator Drop Down Figure 218: Phase Gen Operation Group Panel
Menu

6.4.13 Analyzer Functions

The RA has eight (8) clock and data inputs. The RA provides real-time status for all modules, including the
following functions and indicators, as shown in Figure 219.

e BERT Monitor — Bit error rate, error count, errored seconds, link availability, and equivalent estimations of
the activity based on DQM; relative to BERT restart

e  Measurement Interval Displays — Elapsed time, bit rate, and bit count; relative to BERT restart

o BERT Indicators — Data inversions, bit errors, pattern sync loss, clock slip, DQE sync loss, and estimated
bit errors based on DQM

e BERT Control — Sets data patterns, time limits, and bit error count limits
e  BERT Operation Group — Synchronizes the completion of all the BERTS in the group

e DQE — Extracts DQM information from DQE frames to facilitate DQM verification testing and estimated
error counts, even with unknown data patterns
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6.4.13.1 BERT Functions

Figure 219: Examples of BERT Related Panels

BERT functionality is divided between BERT configuration and BERT monitoring. BERT configuration is separate
from BERT monitors because BERTs are commonly configured in a control group, whereas BERT monitors are
only useful if displayed separately.

In addition to providing basic BERT status information and indicators, the BERT Channel Monitor and BERT
Channel Control panels provide equivalent estimations of the status data based on DQM.

6.4.13.1.1 BERT Monitor Panel
The BERT Monitor panel displays the status of the BERTS.

The View menu provides access

to the BERT Monitor panels, as shown in Figure 205.
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Figure 220: View, BERT Drop Down Menu

Five measured parameters from the BERT Channel Monitor panel are described here and highlighted in Figure 221.
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e Bit Error Rate — Continuous display of the bit error rate for the duration of a measurement
e Error Count — Continuous display of the channel error count for the duration of a measurement

e Delta Err — The number of errors detected since the last screen update. When all of the deltas are added up,
the result is the total number of errors.

e  Err Secs — Errored Seconds; the number of severely errored seconds in the measurement interval; A
severely errored second is one where the bit error rate for that second exceeds the Errored Second
Threshold set in the BERT Control Hamburger menu for that BERT.

e Avail - Link Availability; An overall measure of link quality; It is a number between 0.0 and 1.0, and is

errored seconds

total seconds

for the measurement interval.

Five parameters from the BERT Channel Monitor panel that provide estimated status information are described here
and highlighted in Figure 221. ‘E.” in the BERT area is an abbreviation for ‘Estimated’.

e  Bit Error Rate — Bit error rate, based on DQM extracted from DQE.
o  E.Errors — Bit errors based on DQM extracted from DQE

e E.Delta Err — Indicates the number of errors since the last screen update. When all of the deltas are added
up, the result is the total number of errors.

e E.Err Secs — Errored Seconds; the number of severely errored seconds in the measurement interval based
on the DQM

e E.Avail - Link Availability; An overall measure of link quality based on the DQM
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Figure 221: BERT Monitor with BERT
Functions Circled

Figure 222: BERT Monitor with Estimated
BERT Functions Circled
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The BERT Monitor panel is associated with the Clock Monitor, EBERT + BERT, and BEP/BER Correlator blocks
in the RA analyzer section, as shown in the diagram in Figure 223.
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Figure 223: Analyzer, Clock Monitor/EBERT-BERT/BEP/BER Correlator — BERT Monitor Panel

The measurement interval displays show information about the current measurement interval.

e Time — Displays the elapsed time for the measurement interval, in the format Days Hours, Minutes,
Seconds, Milliseconds

e Bit Rate — Continuous display of the channel bit rate for the measurement interval

e Bits — Continuous display of the channel bit count for the measurement interval

Quasonix, Inc.



SuaAasonix

34 Generation Receiver Analyzer

0 000E+00 =

1 ma v 2t 0. DORE +B0

Figure 224: BERT Monitor with Measurement Interval Displays Circled

6.4.13.1.1.1 BERT Status Indicators

Indicators in the BERT Channel Monitor panel are described here and are shown in Figure 225. All inactive
indicators are grey.

Run — Active green, the BERT is running (measuring)

Restart — Active green, the BERT has restarted, either from a manual restart or after the completion of a
time or count limit

Invert — Data Inversion; When the data is inverted, the indicator is active blue.
Errors — Bit Errors; Active red means bit errors were detected in the last observation interval.
Sync — Pattern Sync Loss; Active red means the BERT has lost synchronization with the specified pattern.

Slip — Clock Slip; BERT slips are detected when the received data clock either advances or retards relative
to its associated source clock by a pre-programmed amount. If Slip is intermittently indicated, the receiver
output clock may have a relatively high degree of jitter. If Slip is continuously indicated, the receiver may
have lost lock on its RF input signal. An active red indicator means the incoming clock and the transmit
clock are not synchronous (slipping past one another). The relative clock source is selected in the
associated BERT Control Panel’s Hamburger Menu.

DQE — An active red indicator means the BERT Data Quality Decapsulator has lost DQE frame lock.

E.Errs — Estimated Errors; An active red indicator means the BERT error estimator has estimated that there
are errors.

Quasonix, Inc.



SluAasonix
34 Generation Receiver Analyzer

[IE LT FIIEFENT = 8

1 =
stk i D BT M

0.000E+00O

Lot bei i i 0 GOQE =00
T'r ; dn v .“
I e LR 1 N

LETnn Cimfa L LI Sy il
SOERED 0 i ]

Figure 225: BERT Monitor with BERT Indicators Circled

6.4.13.1.2 BERT Control Panel
The View menu provides access to the BERT Control panels, as shown in Figure 226.
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Figure 226: View, BERT Control Drop Down Menu

The BERT Control panel, shown in Figure 227, is used to set data patterns, time limits, and bit error count limits. A
menu, accessed via the Hamburger icon provides fields for Errored Seconds Threshold, the Clock Slip Reference,
and BERT Operation Group.
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Figure 227: BERT CH1l Control Panel Figure 228: BERT CH1l Control,

Pattern Drop Down Menu

o Pattern — Sets the data pattern used by the BERT; This is a user pattern or a pseudorandom pattern that
repeats based on the chosen pattern/sequence (a shorter pattern looks more regular, a longer pattern looks
more random).

e  PNG6 — Pseudorandom pattern 2°-1 bits in length

e PNO - Pseudorandom pattern 2°-1 bits in length

e PN11 - Pseudorandom pattern 2!!-1 bits in length
e PNI15 — Pseudorandom pattern 2!%-1 bits in length
e PNI17 - Pseudorandom pattern 2!7-1 bits in length
e PN20 - Pseudorandom pattern 2%°-1 bits in length
e PN23 - Pseudorandom pattern 2%*-1 bits in length
e  PN31 - Pseudorandom pattern 23'-1 bits in length

e Any binary pattern between 2 and 32 bits may be typed directly into the Pattern field.
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Figure 229: BERT CH1l Control, Figure 230: BERT CH1l Control,
Error Drop Down Menu Gating Drop Down Menu

e Time Limit — (In seconds) — Sets a specific time limit for the measurement interval

e Count Limit — (Bits) — Sets a specific number of bits, bit errors, or estimated bit errors on which to
terminate the measurement interval

e Count Limit Drop Down Menu
e Bit— The interval is complete after the number of Count Limit bits
e  Error — The interval is complete after the number of Count Limit errored bits
e E.Error — The interval is complete after the number of Count Limit estimated error bits
e  Gating — Determines the BERT interval
e Single — Runs a single measurement interval; The BERT must be restarted manually.
e Repeat — Automatically restarts the BERT when an interval completes

e  Continuous — Continuously runs the BERT unless manually restarted or Count and Time limits are
ignored

e Restart button — Starts (or Restarts) the BERT interval

e  Stop button — Stops the BERT

BERT Control Hamburger Menu

The BERT Control Hamburger menu is used to set three additional BERT parameters: Errored Seconds Threshold,
Clock Slip Reference, and Operation Group, as shown in Figure 231.

e Errored Seconds Threshold — The bit error rate within a one second span that defines the second to be
errored; Used to determine link availability

e  Clock Slip Ref — Timing reference used to determine clock synchronization (slip); this should match the
data source for the generated signal

e  Operation Group — The BERT Operation Group this BERT is a member of, if any
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Figure 233: Operation Group

Figure 231: BERT CH1l Figure 232: Clock Slip Ref
Drop Down Menu

Control Hamburger Menu Drop Down Menu

The BERT Control panel is associated with the EBERT + BERT block in the RA analyzer section, as shown in the
diagram in Figure 234.
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Figure 234: Analyzer, EBERT-BERT — BERT Control Panel
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6.4.13.1.3 BERT Operation Group Panel

BERT Operation Groups are used to synchronize the completion of all the BERTs in the group. When the operation
group is complete, all BERTS in the group are stopped. This allows automated data collection from multiple BERTs.

Operation Groups are a RA hardware construct that the RA hardware uses to coordinate the operation of multiple
instances of the same module type. For example, BERTSs can be configured to declare completion as a set. Note, this
differs from Control Groups, which are an RxAn software construct that allows multiple instances to be configured
identically through the GUI (refer to section 6.4.1).

The View menu provides access to the BERT Operation Group panels, as shown in Figure 235.

The BERT Operation Group panel, shown in Figure 236, is used to set parameters for BERT Operation Group
Completion Mode.
e Completion Mode — Drop down menu selections Any or All

Any specifies the measurement interval of the operation group complete when any of the BERTs in the
group are complete.

All specifies the measurement interval of the operation group complete when all of the BERTs in the group
are complete.

e Restart Button — Restarts all BERTSs in the BERT operation group
e  Stop Button — Stops all BERTs in the BERT operation group

e Running Indicator — When this indicator is active green, the BERTSs in the operation group are
running/enabled.

e  Group Members — List of BERTS that have been assigned to this operation group using the Operation
Group drop down menu in the BERT Control panel Hamburger menu
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Figure 235: View, BERT Group Drop Down Menu Figure 236: BERT Operation Group Panel
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The BERT Operation Group panel is associated with the BERT Coordinator block in the RA analyzer section, as
shown in the diagram in Figure 237.

Receiver Analyzer
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Figure 237: Analyzer, BERT Coordinator — BERT Operation Group Panel

6.4.13.2 Data Sync Panel

Data synchronization uses pattern matching to detect when the receiver output matches—or fails to match—a
predefined pattern. Because the RA generates the RF signal into the receiver under test, it can measure the amount
of time required from signal present to pattern match (sync time) and from signal loss to pattern mismatch (sync loss
time, i.e., receiver latency). The difference of these, i.e., sync time minus latency, represents the true measure of the
number of bits that may be lost from the end of a flat fade until the receiver produces usable data.

Supplied sync time measurement scripts change both RF outputs simultaneously, so sync time measurement for all
inputs is initiated by a single timing event. However, in general use, the RA can produce potentially different RF
outputs. Therefore, sync time measurement assumes that CH1 (and Combiner and BSS) inputs are driven from RF
Output CHO; and that CH2 (and Combiner and BSS) inputs are driven from RF Output CH1. So, if the RF output
signals are controlled independently, sync active and inactive time will only be measured for the preceding subsets
of input channels.

The underlying mechanism for measuring sync time is based on a statistical model of errored data. It is highly robust
across a broad range of error conditions as high as le-1 bit error rate (BER). However, measured results vary from
trial to trial depending on several factors, including BER. Therefore, sync time should be measured over several
trials, especially for modulations using block encoding (LDPC and STC). Moreover, because sync active time is
measured from RF signal applied to valid data out of the receiver, this measurement includes any fixed latency
within the receiver. To determine the true number of bits lost due to receiver synchronization, sync time should
always be calculated as the measured sync time minus the average sync loss (latency) time.

The View menu provides access to the Data Sync panels, as shown in Figure 238.
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The Data Sync panel, shown in Figure 239, is primarily intended to monitor sync and sync loss time. After being
configured, the synchronization detector constantly monitors receiver synchronization. Any time RF or Signal is set
active/inactive in the RF Output panel, the associated synchronization/latency time is measured and indicated in the
Data Sync panel.

e Last— The most recent event
e Active — Average sync time
e Inactive — Average sync loss (latency) time
The number of active/inactive events over which the average is calculated is also displayed as Count.

All values are in units of bits.
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Figure 238: Data Sync Drop Down Menu Figure 239: Data Sync BSSI Panel

The synchronization detector is configured by selecting the pattern to detect, as shown in Figure 240. Note that,
unlike the BERT, the pattern must be matched exactly; inverted patterns will not be detected. The pattern may be set
explicitly in the Data Sync panel.

It may also be selected automatically. A menu, accessed via the Hamburger icon, provides the ability to set Pattern
Follow to Auto, as shown in Figure 241. In this case, the pattern follows the pattern selection of the Data Generator
selected in the BERT Control panel Hamburger menu Clock Slip Reference for the same channel. For example,
suppose BERT CHI1I has DGO selected as the Clock Slip Reference, and DGO is set to PN31. Then selecting Auto in
the CH1I Data Generator Pattern Follow makes PN31 the CH1I data sync pattern.

e Pattern — Sets the data pattern used by the RA; This is a fixed pattern or a pseudorandom pattern that
repeats based on the chosen pattern/sequence (a shorter pattern looks more regular, a longer pattern looks
more random)

e PN6 - Pseudorandom pattern 2°-1 bits in length
e PNO - Pseudorandom pattern 2°-1 bits in length

e PN11 - Pseudorandom pattern 2!!-1 bits in length
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e PN15 - Pseudorandom pattern 2!°-1 bits in length

e PNI17 - Pseudorandom pattern 2!7-1 bits in length

e PN20 - Pseudorandom pattern 2%°-1 bits in length

e PN23 - Pseudorandom pattern 2%3-1 bits in length

e  PN31 — Pseudorandom pattern 2°!-1 bits in length

e Any binary pattern between 2 and 32 bits may be typed directly into the Pattern field.
e Reset Button — Resets the Data Sync Active/Inactive statistics

e Synced Indicator — When this indicator is active green, the data sync detect is active (sync pattern is

matched).
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Figure 240: Pattern Drop Down Menu Figure 241: Data Sync Hamburger Menu
and Pattern Follow Drop Down Menu

The Data Sync Hamburger menu also allows Window Length and Threshold selections. These are advanced
capabilities and should only be changed in consultation with Quasonix support.

Sync detect timing measures the number of bits required from an arming trigger event until data sync is detected.
This is normally an RF or Signal ‘On’ event. Sync loss timing is the number of bits until data sync has been lost. It,
by definition, starts from a synced condition.

There are three arming triggers from both CHO and CH1 RF channels. All of the triggers from a single channel must
occur (ANDed together) for the sync detect to be armed from either RF channel (ORed) to arm the sync detect. The
default is RF On and Signal On AM Trigger Off, on both channels. This allows simultaneous triggering on
individual channels and combiners/BSSs.

e  RF On — The bit counting starts when the RF is turned on. (Refer to section 6.4.11.)
e  Signal On — The timing starts when the Signal is turned on. (Refer to section 6.4.11.)

e AM Trigger — The timing starts on the rising edge of the AM Trigger status output signal. (Refer to section
6.4.3 and section 6.4.9.)
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The Data Sync panel is associated with the Data Monitor block in the RA analyzer section, as shown in the diagram
in Figure 242.

Recalver Analyzer
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Figure 242: Analyzer, Data Monitor — Data Sync Panel

6.4.13.3 DQE (Data Quality Encapsulation) Panel

Data Quality Encapsulation is the process of bundling data quality information along with payload data. This
information is intended for use by a Best Source Selector (BSS) to optimally select correct payload data bits from
amongst multiple streams of potentially errored payload data. Detailed information about DQE and DQM is
available in IRIG 106-22, Appendix 2-G.

The View menu provides access to the DQE panels, as shown in Figure 243.

The DQE panel, shown in Figure 244, sets the Frame Length, and enables/disables other frame activity.
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Figure 243: View, DQE Drop Down Menu Figure 244: DQE CH1l Panel

e Frame Length — Sets the DQE frame length; may be typed manually or detected automatically

e  Frame Detect — When checked, automatically detects the DQE frame length (generally recommended
unless DQE framing is ‘broken’ on the receiver under test)

e  Decapsulate — Decapsulate has three states Off, On, and Auto. Off disables all DQE decapsulation,
regardless of whether encapsulation is present. On always attempts to decapsulate DQE. This can cause
issues if the receiver does not have DQE enabled. Auto attempts to detect valid DQE and, if found,
automatically decapsulates.

e Frame Counts — When checked, enables frame counts. Counts can be paused to verify that total frame and
locked frame counts are equal by unchecking this check box. Re-checking it resets the frame counts.

e Reset Button — Resets the Total Frames and Locked Frames counters

e Locked Indicator — When this indicator is active green, the data quality encapsulation frame lock is active
(DQE detected).

e  Decap Indicator — Shows decapsulation is active, either when Decapsulate is set to On, or if Decapsulate is
set to Auto and DQE Lock is indicated

e  Frames — Shows the count of total DQE frame headers
e Locked — Shows the count of the properly bounded DQE frames, with a DQE header before and after

e Delta — Shows the difference between Frames and Locked; this is the number of bad or dropped DQE
frames detected

The DQE panel is associated with the Data Quality Decapsulator block in the RA analyzer section, as shown in the
diagram in Figure 245.
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Figure 245: Analyzer, Data Quality Decapsulator — DQE Panel

6.5 Measurement Overview

RxAn provides scripts to facilitate automated, repeatable measurements. While the RA provides almost limitless
capability for users to create their own measurements, the most common ones are provided in the included RA
resources.

The provided scripts configure test-specific settings as needed prior to or during execution of the measurement.
However, they also rely on other basic settings to be configured by the project file. It is strongly recommended that
the provided project files, or modifications of them, be used in conjunction with the provided measurement scripts.
Any required deviations from the project defaults are noted below. In all cases, basic settings in the receiver under
test (frequency, mode, bit rate) must match.

Even though these measurements alter settings during execution, by default they restore all RA settings to their pre-
measurement state on completion. This is true whether the measurement completes normally or due to user
intervention. Generally, this avoids confusion caused by residual unknown settings changes. However, it may also
cause a difference in operation between manual testing and measurement script execution. For example, DQE
decapsulation is enabled during all DQM measurements, whether it is enabled prior to the measurement or not. If
DQE decapsulation is not enabled manually, DQE/DQM will appear to be broken even though DQE/DQM tests may
indicate no problems.

6.5.1 Measurement Panel

Access to measurement scripts and execution status is provided via the Measurement panel, as shown in Figure 246.
This section describes the operation of the Measurement panel, while detailed explanations about automated
measurements are located in section 6.6.

1. Click on the Hamburger icon in the upper left corner of the Measurement screen to access the Measurement
Hamburger menu, as shown in Figure 247.
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2. Click on the Load button to select and load a script.
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Figure 246: Measurement Figure 247: Measurement Hamburger Menu

When a script is loaded, the script title displays in the Measurement panel, as shown in Figure 248. Click
on the information icon (I in a circle) to display information about the selected script, as shown in Figure

249.
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Figure 248: Measurement Script Title Figure 249: Measurement Script Description
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3.  Commonly used variables for the loaded script are set by clicking on the Edit icon (paper and pencil) in the
upper right corner of the Measurement panel.

4.  When the Edit screen displays, in this example BER — RF Level Sweep, type the desired values in each
field, then click on the Close button.
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Figure 250: Example Measurement Edit Script Parameters Window

5. To start the measurement, click on the Start button at the bottom of the Measurement screen, as shown in
Figure 251. The buttons are as follows, left to right: Start, Stop, Enable Single Step, Step, and Skip this
Step.
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Figure 251: Measurement Buttons

e  Start — The Start Measurement button is used to start a new measurement. The Running indicator
turns green. In addition, the Start information field is populated with the date and time the
measurement was started.

e Pause — After clicking on the Start button, it changes to a Pause button. This indicates the
measurement is running and may be paused by clicking on this button.

When a measurement is paused, the Paused indicator changes to red. This indicates that the
measurement is running, but is in a paused state and is waiting for the user to take action. Click on
the Pause button. The button changes back to a Start button. Click on Start to resume.

e Stop — The Stop Measurement button immediately terminates a measurement. The Canceled
indicator turns red, and all other indicators turn grey. In addition, the End information field
displays the date and time the measurement was stopped.
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Enable/Disable Single Step Mode — Single step can be used to debug measurement scripts

e Step — Used for manual stepping

Skip This Step — A measurement step can be skipped if a measurement halts, either because of a
bug in the script or the terminating condition for that step never occurs. Any data collected for that

step will be marked as invalid.

When the script is running, the Measurement panel displays the Start date and time, details about the script
being executed, and colored indicators. All measurement indicators are shown in Figure 252.

Indicators

Indicators include Running, Waiting, Single, Paused, Complete, and Canceled.

The window shown in Figure 258, is titled with the name of the measurement .rmr file. This is the central collection
of all charts for a set of measurement results. It shows a sample of the measurement chart(s) and provides the option

Running — When this indicator is active green, a measurement is running.
Waiting — When this indicator is active orange, the measurement engine is waiting for a step to complete.
Single — When this indicator is active orange, the measurement engine is in single step mode.

Paused — When a measurement is paused, the Paused indicator changes to red. This indicates that the
measurement is running, but is in a paused state and is waiting for the user to take action.

Complete — When this indicator is active green, the measurement has completed.

Canceled — When a measurement is stopped, the indicator turns red (all other indicators turn gray).
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Figure 252: Measurement Panel with a Script Paused

of saving the image(s). Multiple charts may be arranged, displayed, and saved.
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Figure 253: Example Results Document

Closing this document closes all of the charts that go with it. The user can selectively display or hide individual

charts by clicking on the appropriate Show check boxes, as shown in Figure 254.
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Figure 254: Example Results Document Showing Individual Charts

Selecting a chart in the results document brings the chart to the front, as shown in Figure 255.
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Figure 255: Example Results Document with Selected Chart in Front

The user can save the charts as images files by clicking on the Save Image button, as shown in Figure 256.
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Figure 256: Example Results Document, Save Image Buttons

The following image file types are supported: .png, .jpeg, .bmp, .tiff, and .gif, as shown in the drop down menu in

Figure 257.
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Figure 257: Example Save Document, Save as Type Drop Down Menu

Some measurements produce many charts. The user can arrange the charts so that they are as visible as possible. The
charts may be stacked along the left, top, right, or bottom of the current screen, or cascaded, as shown in Figure 258.
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Figure 258: Example Results Document, Cascade Button Drop Down Menu
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The Save Document? message, shown in Figure 259, displays when the user tries to close the document without
saving it first.

Figure 259: Save Document Message

File name default structure is: {script file name}_yyyyMMdd_HHmmss.rmr

6.6 Automated Measurements

Automated scripting allows precise measurement using many parameters with rapid acquisition of extremely large
datasets. Saved results files facilitate result aggregation, analysis, presentation, and archival. The RA provides these
measurement using a variety of scripts. These include:

e BER AWGN Sweep

e BERRF Level Sweep

e Sync Time

e  Break Frequency

e Combiner Gain

e Equalizer Multipath Sweep
e BER AWGN Modulation Index Sweep
e DQM-AWGN Sweep

e DQM-AWGN Step

e DQM Resync

e  DQM Monitor
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6.6.1 BER AWGN Sweep

This measurement sweeps the RA-generated Additive White Gaussian Noise (AWGN) level across a range of
Eb/NO values and measures bit error rate (BER) at each level.

e  Variations — Available for 1-channel and 3-channel testing
e Key Parameters

e  Eu/Ny Start/Stop/Step — Eu/Ny starting/stopping/step value (dB); adjust as appropriate per modulation
and coding

e Setup — No change from project defaults

This measurement plots a standard BER curve for each tested channel, as shown in Figure 260.

Figure 260: Example BER AWGN Modulation Index Sweep Graph
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6.6.2 BER RF Level Sweep

This measurement sweeps the RF output level across a range of values and measures bit error rate (BER) at each
level. This is similar to the BER AWGN Sweep test, but it uses receiver front-end noise to set the noise floor.

e  Variations — Available for 1-channel and 3-channel testing

e Key Parameters

e RF Level Start/Stop/Step — RF level starting/stopping/step value (dB); adjust as appropriate per

modulation, coding, and receiver noise figure

e Setup — No change from project defaults

This measurement plots a standard BER curve for each tested channel, as shown in Figure 261.
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Figure 261: Example BER RF Level Sweep Graph
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6.6.3 Sync Time

This measurement alternately enables and disables signal output for several iterations to measure receiver
synchronization time and synchronization loss time, which is a measure of receiver latency. It implements a superset
of the Demodulator Acquisition Time and Flat Fade Recovery Time test in IRIG 118-22, Section 7.4.

The underlying mechanism for measuring sync time is based on a statistical model of errored data. Despite normal
statistical variation, only a small number of iterations is generally required to get good results for most test
conditions. However, block coding such as LDPC introduces discrete acquisition boundaries between codeblocks,
requiring a large number of iterations to cover all timing relations.

e  Variations — Available for 1-channel and 3-channel testing
e Key Parameters
e Iterations — Number of sync/sync-loss measurement iterations

e Signal On/Off Dwell — Signal On/Off minimum dwell time (ms); ensure Off dwell is long enough for
tracking loops to drift and for optional frequency offset to sweep

e CHI1/CH2 Frequency Offset Sweep Rate/Limit — Frequency sweep rate and range; set to force
acquisition at varying offsets from the center frequency

e Setup — Set RA AWGN to the desired level for resynchronization; static BER should be le-1 or lower

This measurement plots separate histograms for sync time, as shown in Figure 262, and for sync loss time, as shown
in Figure 263.

Sync Time Measuramant, PCMFM & 10 Mbps, 3 dB Eb/MND
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Figure 262: Example Sync Time Graph
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Figure 263: Example Sync Loss Time (Latency) Graph

Note: The difference between measured sync time and sync loss time (latency) represents the true measure of the
number of bits that may be lost from the end of a flat fade until the receiver produces usable data.

These histograms present a summary view of sync time performance over all trials. More detailed analysis can be
performed using data saved in .rmr and/or .csv files. In particular, average sync time, average latency, and the
difference between the two may be calculated using this data, as well as min, max, variance, etc. Average sync time
and average latency can also be viewed in the Data Sync panels for the channels being tested.
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6.6.4 Break Frequency

This measurement sweeps the rate at which the two RF outputs are faded out of phase with respect to each other and
measures bit error rate (BER) for both channels and the combiner at each fade rate. It effectively implements the

Combiner Break Frequency test in IRIG 118-22, Section 5.7.

Variations — Available for 3-channel testing (2 channels plus combiner) only

Key Parameters

e Reference BER — USER CONTROLLED target error rate for CH1/CH?2 prior to test start (refer to
Setup bullet)

e Fade Rate Start/Stop/Step — Fade rate starting/stopping/step value (MHz)

Setup — Set RA AWGN or RF level to achieve the reference BER on receiver channels 1 and 2. The default
reference BER is 1e-4, which results in approximately 1e-6 BER for the combiner at low fade rates, as
specified in IRIG 118. If a different reference BER is used, it should be changed in the measurement

parameters.

This measurement plots BER relative to fade rate, as shown in Figure 264.
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Figure 264: Example Break Frequency Graph

The break frequency is the point at which the combiner BER exceeds the reference (threshold) BER. It may be
interpolated in the general case where measurement points straddle the threshold.
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6.6.5 Combiner Gain

This measurement sweeps the Ey/No of RF channel 1 above and below the fixed Ev/Np of RF channel 2 and measures
the BER for both channels and the combiner at each Eb/NO step. It effectively implements the Diversity Combiner
Static Evaluation with Unequal RF Signal Strengths test in IRIG 118-22, Section 5.2.

e  Variations — Available for 3-channel testing (2 channels plus combiner) only
e Key Parameters

e CHI1 Ew/Ny Start/Stop/Step — Variable-channel Ew/Nj starting/stopping/step value (dB); should range
from above to below static-channel Ey/Ng

e  (CH2 E/Ny — Static-channel Ey/Ny (dB)
e  Setup — No change from project defaults

This measurement plots BER relative to channel 1 E/Nj and re-plots combiner BER relative to the calculated
theoretical combiner Ey/Ny, as shown in Figure 265.
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Figure 265: Example Combiner Gain Graph

Perfect combiner gain, as described in RCC 119-06 Section 4.4.12, would place the re-plotted combiner BER curve
(dark gold) on top of the channel 1 BER curve (blue). Any difference shows a shortcoming in combiner gain.
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6.6.6 Equalizer Multipath Sweep

This measurement sweeps the amplitude and/or phase of one or two multipath reflection rays and records estimated
bit error probability (BEP) based on DQM at each combination. It implements a superset of the System Bit Error
Rate for Static 3-ray Channels test in IRIG 118-22, Section 10.1.

Note: This measurement relies on estimated bit error probability (BEP) from DQM rather than measured bit error
rate (BER) to test a large parameter space in relatively short time. As such, it requires DQM to be accurate under
multipath conditions. This must be verified by a separate test to ensure validity of equalizer measurement results.

e  Variations — Available for 1-channel testing only
e Key Parameters

e Ray 0 Magnitude Start/Stop/Step — First reflection magnitude starting/stopping/step value (relative to
desired signal)

e Ray 0 Phase Start/Stop/Step — First reflection phase starting/stopping/step value (degrees)
e Ray 0 Delay — First reflection delay value (ns); ensure this is scaled properly based on bit rate

e Ray 1 Magnitude Start/Stop/Step — Second reflection magnitude starting/stopping/step value (relative
to desired signal)

e Ray 1 Phase Start/Stop/Step — Second reflection phase starting/stopping/step value (degrees)
e Ray 1 Delay — Second reflection delay value (ns); ensure this is scaled properly based on bit rate

Default parameters for this measurement test the IRIG 118 “Mild”, “Moderate”, and “Severe” impairment static
3-ray channels across all phases of the specular reflection. These three channels correspond to ray 0 magnitudes
of 0.7, 0.85, and 0.9 respectively; magnitudes of 0.75 and 0.8 are also tested. Note that any change in bit rate
requires adjusting the delay parameters accordingly.

e Setup
e Enable DQE in the receiver under test and decapsulation in the RA.
e Enable/disable equalization in the receiver under test as desired.
e Set RA AWGN to desired level (IRIG 118 recommends 20 dB Eb/NO).

This measurement plots BEP relative to phase at each magnitude, as shown in Figure 266 (without equalization) and
in Figure 267 (with equalization).

It may be useful to compare results without equalization and with equalization. Link availability under the chosen
multipath conditions may be estimated by noting the percentage of phases at which BEP exceeds le-5.
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Figure 266: Example Multipath Sweep BEP Graph, Without Equalization
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Figure 267: Example Multipath Sweep BEP Graph, With Equalization
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6.6.7 BER AWGN Modulation Index Sweep

This measurement sweeps the modulation index (PCMFM only) and Ew/Nj across a range of values and records the
bit error rate (BER) at each combination. It implements a superset of the PCM/FM Demodulator Modulation Index

Sensitivity test in IRIG 118-22, Section 7.6.

e  Variations — Available for 1-channel testing only

e Key Parameters

e Mod Scale Start/Stop/Step — Modulation scale starting/stopping/step value (dB); this scale is applied as
a multiplier on the default modulation index of 0.7, so a scale range from 0.5 to 5 results in a

modulation index range of 0.35 to 3.5

o Eu/Nj Start/Stop/Step — Ev/Nj starting/stopping/step value (dB)

e Pre-BER Dwell — Dwell time after setting mod scale before BER measurement (ms); ensure enough
time for modulation index tracking to occur in the receiver (at high Ey/No) before measuring BER

e Setup

o Set the IF bandwidth in the receiver under test to accommodate the required bandwidth (at least double

the normal bandwidth if the modulation index will exceed 1.0).

o Enable receiver modulation index tracking or other mitigation settings as desired.

This measurement plots BER relative to modulation index at each magnitude, as shown in Figure 268.
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Figure 268: Example Modulation Index Sweep BER Graph
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6.6.8 DQM AWGN Sweep

This measurement sweeps the RA-generated Additive White Gaussian Noise (AWGN) level across a range of Ey/Ny
values to measure DQM accuracy and response to static noise conditions. It implements the BER versus Estimated
BEP (DQM) with Additive Noise test in IRIG 118-22, Section 11.1.

e  Variations — Available for 1-channel and 3-channel testing
e Key Parameters

e Eu/No Start/Stop/Step — Eu/Ny starting/stopping/step value (dB); adjust as appropriate per modulation
and coding

e Setup — Enable DQE in the receiver under test and decapsulation in the RA.

This measurement plots a standard BER curve for each tested channel, along with corresponding BEP curves, as
shown in Figure 269.

[l Dokt BR Cars

AWGHN Sweap DOM Measurement, PCMFM & 10 Mbps

Figure 269: Example AWGN Sweep DQM Graph

Ideally, the estimated BEP curve should lie directly in line with the measured BER curve, within the extents of the
error bars. These bars indicate 95% Clopper-Pearson confidence intervals based on the number of bits and the
number of errors counted at each Ew/Ny level and are intended to illustrate imprecision of the measured BER due to
small sample size.

When this measurement completes, it also plots distribution and correlation charts. To generate these charts, the RA
accumulates information over all DQE frames in the measurement on a frame-by-frame basis. The 65,536 possible
DQM values are assigned into 256 bins, each containing 256 successive DQM values. Each bin has three pieces of
information associated with it:
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e A count of bits from all DQE frames with DQM value in the bin
e A count of errors from all DQE frames with DQM value in the bin
e The average BEP represented by the 256 DQM values in the bin

So, for each DQM frame received, the RA counts the number of bits and the number of bit errors, and adds those to
a running total for the bin associated with the DQM value in the frame. At the end of the test, each bin has a count of
the total bits and the total bit errors that occurred in that bin. In addition, each bin has a count of estimated bit errors,
calculated by multiplying the count of total bits by the average BEP represented by the bin. These three quantities
are plotted for each bin (BEP) in the distribution chart, as shown in Figure 270.
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Figure 270: Example AWGN Sweep DQM Distribution Graph

The scatter plot of bit count shows how uniform the BEP estimates were over the course of the measurement.
Clumps may be used to identify discrete BEP levels that occurred.

Ideally, the count of estimated bit errors should lie directly in line with the count of measured bit errors. However,
near the bottom of the chart, it is not uncommon for some measured errors to appear as “outliers.” These may not
indicate an actual departure from the ideal. Measured errors only occur in integer quantities; each bit is either
errored or not, but estimated errors can occur in fractional quantities; a BEP of 1e-6 over a DQE frame with 4096
bits indicates an estimated 0.004096 bit errors in that frame. In this example, an actual measured bit error would be
expected statistically once every 250 frames.

The same information can be used to calculate the measured bit error rate (BER) for each bin as the count of errors
divided by the count of total bits. The BER is plotted for each bin (BEP) in the correlation chart shown in Figure
271.
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Figure 271: Example AWGN Sweep DQM Graph, BER for Each BEP

Ideally, the measured BER should lie directly on the gray 1:1 line of BER=BEP, within the extents of the error bars.
Outliers identified near the bottom of the distribution plot may be judiciously discounted. However, no points should
ever appear on the y-axis; the worst possible DQM ‘sin’ is to indicate that data is “perfect” when it in fact contains

CITOrS.
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6.6.9 DQM AWGN Step

This measurement rapidly steps the RA-generated Additive White Gaussian Noise (AWGN) level across a set of
Ew/No values to measure DQM accuracy and response to dynamic channel conditions. It implements the Estimated
BEP (DQM) Step and Dwell Response test in IRIG 118-22, Section 11.2.

e  Variations — Available for 1-channel and 3-channel testing
e Key Parameters

e Cycles — Number of Ey/Nj cycles; each cycle is a triangle step: mid, high, mid, low, (mid, high, mid,
low...)

e Eb/NO low, mid, high — Ew/Ny levels to cycle through (dB)
e Setup — Enable DQE in the receiver under test and decapsulation in the RA.

This measurement produces no chart while it is executing. When this measurement completes, it plots distribution
and correlation charts as described above and shown in Figure 272 and Figure 273.
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Figure 272: Example AWGN Step DQM Distribution Graph
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Figure 273: Example AWGN Step DQM Correlation Graph
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6.6.10 DQM Resync

This measurement alternately enables and disables signal output for several iterations to measure DQM accuracy
and response to lock loss and acquisition. It implements the DQM (BEP) Resynchronization Response test in IRIG
118-22, Section 11.6.

e  Variations — Available for 1-channel and 3-channel testing
e Key Parameters
e [Iterations — Number of resynchronization cycles; each cycle is off, on, (off, on, ...)

e Signal On/Off Dwell — Signal On/Off minimum dwell time per step (ms); ensure Off dwell is long
enough for tracking loops to drift

e Setup
e Set RA AWGN to the desired level for resynchronization.
e Enable DQE in the receiver under test and decapsulation in the RA.

This measurement produces no chart while it is executing. When this measurement completes, it plots distribution
and correlation charts as described above and shown in Figure 274 and Figure 275.
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Figure 274: Example Resynchronization DQM Distribution Graph
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Figure 275: Example Resynchronization DQM Correlation Graph

Note: Because this measurement results in total sync loss in the receiver, it also results in total sync loss in the RA
BERT. If receiver synchronization occurs right at the end of a DQE frame, it is possible that BERT
resynchronization could span into the next DQE frame. This could result in errors appearing in a DQE frame with
“perfect” DQM. The RA BERT is designed to synchronize with effectively zero delay in the absence of bit errors, so
the preceding scenario is highly unlikely. However, should bit errors be noted at very low BEP, then the test may be
re-run or the errors may be discounted if they are few in number. In any case, a large number of errors at low BEP
indicates a problem with receiver DQM.
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6.6.11 DQM Monitor

This measurement allows the user to manually control test conditions to measure DQM accuracy and response to
any desired channel condition(s). During the manual test, the RA monitors receiver output to compare estimated
BEP performance from DQM with actual measured BER performance. Among other uses, it may be used to
implement as-yet unautomated tests in IRIG 118-22, Sections 11.3-11.5.

e  Variations — Available for 1-channel and 3-channel testing
e Key Parameters

e Number of Steps — Number of manual test steps for complete measurement; set to 1 to run a single test
condition

e Setup
e Set RA or other signal source to the general desired conditions.
e Enable DQE in the receiver under test and decapsulation in the RA.

e  After starting the measurement, establish the specific first test condition and then click on the Play icon
in the Measurement panel. When BER measurement for that condition is complete, repeat setup, then
click on Play for each subsequent test condition, until all test steps have been completed.

This measurement plots BER for each tested condition, along with corresponding BEP, as shown in Figure 276.
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Figure 276: Example Passive Monitor DQM Graph

When this measurement completes, it also plots distribution and correlation charts over all tested conditions as
described above and shown in Figure 277 and Figure 278.
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Figure 277: Example Passive Monitor DQM Distribution Graph
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Figure 278: Example Passive Monitor DQM Correlation Graph
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6.7 Measurement Results

One or more charts may be produced while a measurement runs or after a measurement completes. This includes a
chart manager which provides simple access to view and save results. Measurement results can be saved in multiple
formats. The .rmr format is the native RA measurement result file and includes all information recorded during a
measurement. The .rmr files can be loaded into the RA application to display the complete results again. Use the
File menu, Open option to load measurement results.

6.7.1 Export Measurement Results

The RxAn measurement system can collect large and complex data sets. The RxAn Measurement Results file (.rmr)
format stores this data, along with the display descriptions, so that the data can be reloaded and redisplayed, just as it
was when the measurement was taken. While the .rmr file is stored in XML format and can be parsed by any XML
reader, it is not directly processable in packages such as Microsoft Excel. As such, measurement data can be saved
in the more common Comma Separated Value (.csv) format, which can be easily loaded into Microsoft Excel.

.csv files are inherently a two dimension table, with a single independent variable and one or more dependent
variables. This can be a simple as a Bit Error Rate curve where independent variable is Eb/NO and the dependent
variable is Bit Error Rate. Even the simple Bit Error Rate measurement can produce more complex datasets,
including Bit Error Probability and data from multiple channels. RxAn measurement is not limited to a single
independent variable and can nest multiple variables. Measurements such as Equalizer performance have an inner
loop with the IPATH phase angle that sweeps 360 degrees, and an outer loop of IPATH magnitude. A third
independent variable could be added that sweeps Eb/NO or, in PCMFM, modulation index.

These complex datasets cannot be well expressed in a single, flat two dimension table such as a .csv file. In these
cases, multiple .csv files can be created from a single .rmr file to separate multiple independent variables and group
dependent variables.

It should be noted that .csv files cannot be reloaded into RxAn. The user should always save results in the .rmr
format first.

Datasets are configured as one or more series, each containing one or more sets of datapoints that are recorded for
each measurement step. The datapoints are both the dependent and independent variables and no distinction is made.

To save results as comma separated values:

1. Select File>Save as...to open the Save As window.
2. Click on the down arrow in the Save as type field to display the drop down menu.

3. Select CSV Files (*.csv), as shown in Figure 279.
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Figure 279: Example Save Measurement Results Drop Down Menu Selection

An Export .csv dialog box displays, as shown in Figure 280. The contents vary depending on the results data.
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Figure 280: Examples of Export .CSV Data Selection Dialog Boxes

At least one series and one datapoint must be selected. Selecting a parent check box causes all child check boxes
below it to be checked, as shown in Figure 281.
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Figure 281: Export: BER-AWGN Sweep Data Selection with Parent Parameters Checked

If only some of the child parameters are checked, the parent check box contains a black square indicating a partial
subset of children is selected, as shown in Figure 282.
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Figure 282:Export: BER-AWGN Sweep Data Selection with Some Parameters Checked

A simple Bit Error Rate with a single series, shown in Figure 283, produces a single series .csv export dialog box, as
shown in Figure 284.
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AWGN Sweep BER Measurement, PCMFM & 10 Mbps

Figure 283:Simple BER with Single Series Chart
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Figure 284: Single Series Export .CSV Dialog Box
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Some measurements produce multiple independent variables and a set of datapoints for each, as shown in Figure
285 and Figure 286.

Mubtipath Sweep BEF Measurement. PCMES & 10 Mbps
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Figure 285: Measurement Chart with Multiple Independent Variables

| Detect dats bo be enparted

# [ | Equpizes - Migftpeih leren
F| BEPCRT belert Servies and Datapois
& | hevles
|1 BER i gl 57 mag1: 1L, ghi: 30
| IBEF B mangl 07, mmg 1 00 phi: 50
BEF @ magll 0. mug i 0.1, ght; 90
| _\BEP @ ol A5 ;g T2, phlo 90
[ - gl G mag i 01, gt 80
o | Dilapesiniia:
I ]
|| S
: Byt pgrnugs
L = am
Ly ainy
|| Bary 1 hdagrtuche
[y 1Prae
Ay 1 Diwlay
Eiy
Fismutedfrmn
|_IEE®
[ hpsserirmr

| UppesiEivis

ok | Cancil

Figure 286: Export Data Selection with Datapoints for Multiple Variables
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Some measurements produce complex sets of results that can be difficult to express in a single .csv file, such as the
case where the Bit Error Rate measurement also collects Bit Error Probability Correlation. The BEP/BER

measurement creates data that can be expressed in one or more two-dimension curves, as shown in Figure 287. The
BER.BEP correlation results in an entirely different class of data (a histogram).
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Figure 288: Complex Measurement Results Data Selection Parameters
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Selecting multiple series and datapoints allows the option to create multiple .csv files. The names of these files will,
by default, have suffixes appended to the base file name chosen by the user in the Save As dialog box, or the user
may determine the name of each file. Examples are provided in Figure 289.
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Figure 289: Option to Create Multiple .CSV Files in Data Selection Dialog Boxes
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A unique file can be created for each series selected in a complex dataset, as shown in Figure 290.
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Figure 290: Option to Create Unique .CSV Files for Each Series Selected
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Multiple series collected using the same independent variable can produce multiple files, as shown in Figure 291
and Figure 292.

AWGHN Sweep BER Measurement, PCMER & 10 Misps

Figure 291: Multiple Series with One Independent Variable
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Figure 292: Export: Sweep Data Selection with Multiple Files
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7 Maintenance Instructions

The RA requires no regular maintenance, and there are no user-serviceable parts inside.
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8 Product Warranty

The RA carries a standard parts and labor warranty of one (1) year from the date of delivery.

8.1 Quasonix Limited Warranty Statement

This Limited Warranty Statement (this “Limited Warranty”) applies to all hardware and software products and
internal components of such products (the “Products”) sold by Quasonix, or its representatives, authorized resellers,
or country distributors (collectively referred to herein as “Quasonix”). EXCEPT AS EXPRESSLY SET FORTH IN
THIS LIMITED WARRANTY, QUASONIX MAKES NO OTHER WARRANTIES, EXPRESSED OR IMPLIED,
INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE WITH RESPECT TO ANY PRODUCTS SOLD BY IT. Quasonix expressly disclaims all warranties and
conditions not stated in this limited warranty. There are no warranties which extend beyond the description on the
face hereof. Capitalized terms not otherwise defined herein shall have the meaning set forth in those certain General
Terms and Conditions of Sale for Standard Product, as amended from time to time.

Quasonix warrants to customer that for one (1) year from the date of shipment of the Products by Quasonix (the
“Warranty Period”), such Products purchased from Quasonix, or its authorized affiliate will materially conform to
the specifications set forth in the applicable Quasonix Specifications, if any, and are free from defects in materials
and workmanship under normal use during the Warranty Period. As used herein, “normal use” means the intended
use of the Products for which it was designed by Quasonix.

This Limited Warranty extends only to the original purchaser of the Products and is not transferable to anyone who
obtains ownership of the Products from the original purchaser.

Quasonix’s software, whether incorporated into the Products or sold separately, is warranted solely to the extent that
problems or “bugs” are found in the software and affect the functional operation of the Products. At no time shall
requests for changes in the software architecture or visual esthetics be considered a warranty item.

The Products are manufactured using new materials only. Replacement parts may be new or equivalent to new.
Replacement parts are warranted to be free from defects in material or workmanship for thirty (30) days or for the
remainder of the Warranty Period of the Products in which they are installed, whichever is longer.

During the Warranty Period, Quasonix will repair or replace the defective Products. All components or hardware
products removed from the Products under this Limited Warranty become the property of Quasonix. All warranties
are limited to the repair or replacement of the Products.

In no event shall Quasonix be liable for any special, consequential, incidental or indirect damages of any kind,
including, without limitation, loss of profits, loss of data, “down-time,” loss of use or damage to other equipment, or
personal injury or death, whether or not Quasonix has been advised of the possibility of such loss.

Notwithstanding anything to the contrary herein, Quasonix’s entire liability hereunder from any cause whatsoever
and regardless of the form of action shall be limited to the amount actually received by Quasonix.

Quasonix shall not be liable for a breach of the warranty set forth in this Limited Warranty unless: (i) the customer
gives written notice of the defect, reasonably described, to Quasonix’s Contracts Administrator within thirty (30)
days of the time when customer discovers or ought to have discovered the defect and obtains a Return Materials
Authorizations (“RMA”) number; (ii) Quasonix is given a reasonable opportunity after receiving the notice to
examine such Products and customer (if requested to do so by Quasonix) returns such Products to Quasonix’s
facility in Moorpark, CA, unless otherwise approved by Quasonix; and (iii) Quasonix reasonably verifies customer’s
claim that the Products are defective.

Subject to the foregoing, with respect to any such Products during the Warranty Period, Quasonix shall, in its sole
discretion, either: (i) repair or replace such Products (or the defective part) or (ii) credit or refund the price of such
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Products at the pro rata contract rate provided that, if Quasonix so requests, customer shall, at Quasonix’s expense,
return such Products to Quasonix.

The customer is responsible for all costs associated with packaging and shipping of the defective Products to
Quasonix’s facility and clearly marking or affixing the given RMA number on the shipping label. Quasonix is not
responsible for any loss or damage during shipment to Quasonix’s facility. Following repair or replacement of
covered Products, Quasonix will assume responsibility for the costs associated with the return of the material to the
customer to an address provided by the customer. Notwithstanding the foregoing, items returned to Quasonix’s
facility and found to be operational or otherwise not covered by this Limited Warranty shall be returned to the
customer at the customer’s expense.

This Limited Warranty does not apply to expendable parts, such as cables, lamps, fuses, connectors, etc. This
Limited Warranty does not extend to any Products which have been damaged or rendered defective (a) as a result of
accident, misuse, abuse, or external causes; (b) by operation outside the usage parameters stated in the user
documentation that shipped with the Products; (c) as a result of a failure to follow the instructions in the Operations
& Maintenance Manual (d) by the use of parts not manufactured or sold by Quasonix; or I by modification or
service by anyone other than (i) Quasonix, (ii) an Quasonix authorized service provider, or (iii) your own installation
of end-user replaceable Quasonix or Quasonix approved parts if available for the Products in the servicing country.

THE TERMS OF THE WARRANTIES CONTAINED HEREIN DO NOT IN ANY WAY EXTEND TO ANY
PRODUCT OR PART THEREOF OR SOFTWARE MATERIALS WHICH WERE NOT MANUFACTURED BY
SELLER OR PREPARED BY SELLER OR ANY OF ITS AFFILIATES.

These terms and conditions constitute the complete and exclusive warranty agreement between the customer and
Quasonix regarding the Products purchased. This Limited Warranty is applicable in all countries and may be
enforced in any country where Quasonix or its authorized affiliates offer warranty service subject to the terms and
conditions set forth in this Limited Warranty.

These terms and conditions supersede any prior agreements or representations (including representations made in

Quasonix sales literature or advice given to the customer by Quasonix or an agent or employee of Quasonix) that

may have been made in connection with the purchase of the Products. No change to the conditions of this Limited
Warranty is valid unless it is made in writing and signed by an authorized representative of Quasonix.

8.1.1 Extended Warranties
Extended warranties or extra coverage are available upon request. Please contact Quasonix for details and pricing.
THE REMEDIES SET FORTH IN THIS LIMITED WARRANTY STATEMENT SHALL BE THE

BUYER’S SOLE AND EXCLUSIVE REMEDY AND SELLER’S ENTIRE LIABILITY FOR ANY
BREACH OF THE LIMITED WARRANTY SET FORTH HEREIN.

052217mbb002

Quasonix, Inc.



SluAasonix
34 Generation Receiver Analyzer

9 Technical Support and RMA Requests

In the event of a product issue, customers should contact Quasonix via phone (1-513-942-1287) or e-mail
(support@quasonix.com) to seek technical support. If the Quasonix representative determines that the product issue

must be addressed at Quasonix, a returned materials authorization (RMA) number will be provided for return
shipment.

Authorized return shipments must be addressed in the following manner:

Quasonix, Inc.
ATTN: Repair, RMA #
6025 Schumacher Park Drive
West Chester, OH 45069

To ensure that your shipment is processed most efficiently, please include the following information with your
product return:

e  Ship To — Company name, address, zip code, and internal mail-drop, if applicable
e  Attention/Contact person — Name, Title, Department, Phone number, email address
e Purchase Order Number — If applicable

e RMA Number — provided by the Quasonix representative

Please note that Quasonix reserves the right to refuse shipments that arrive without RMA numbers.
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10 Appendix A — RxAn Project Files

As mentioned in section 6.3.1.2, project files contain all of the RA settings in effect at the time the project file was
saved, including the RxAn GUI layout. This is particularly useful for establishing a known-good repeatable
configuration for measuring or to leave a “breadcrumb” during troubleshooting or analysis. Certain state
information, such as what measurement was most recently loaded in the Measurement panel, is not saved. Since
layouts can also be saved separately, it is easy to load a project and then to load an alternate layout if desired. There
is no practical limit to the number of projects that may be saved for later use.

The provided projects contain some settings that are required for use with the provided measurement scripts. It is
strongly advised that these projects, or projects derived from them, be used when running these measurements.
These baseline projects should never be modified.

BasicSTC.rxan is similar to Basic.rxan but uses a pair of modulators and STC encoding to generate a composite
STC waveform on both RF output channels, as shown in Figure 293. This composite waveform has identical
amplitude, phase, and delay on both components of the STC waveform.

o ubation

Summer
Data Encoder [T Modulator I
Generator " 5T " soarsk] [ i_:’]—

TRC0 ) Madulaton [T
 NEGET | FEQu =

Figure 293: Example of Project BasicSTC.Rxan

CompleteSTC.rxan uses multipath capability to allow varying the amplitude, phase, or delay on either component of
the STC waveform, as shown in Figure 294. By default, it still outputs the composite STC waveform on both RF
output channels, but it can easily be configured to output pilot 1 on RF channel 1 and pilot 2 on RF channel 2 or vice
versa.
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Figure 294: Example of Project CompleteSTC.Rxan
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11 Appendix B — Data Quality Encapsulation (DQE) Concepts

Data Quality Encapsulation is the process of bundling data quality information along with payload data. This
information is intended for use by a Best Source Selector (BSS) to optimally select correct payload data bits from
amongst multiple streams of potentially errored payload data. Detailed information about DQE and DQM is
available in IRIG 106-22, Appendix 2-G.

Data quality is encoded as a Data Quality Metric (DQM). When calibrated per a standardized procedure, DQM
based on bit error probability (BEP) allows DQE from multiple vendors to interoperate.

Bit Error Probability (BEP) is the calculated likelihood that a bit is in error. A very low BEP can be determined from
only a few bits. BEP does not require any known data and can be determined quickly and accurately from
demodulator statistics. It is an unbiased quality metric, regardless of channel impairments. The DQM is calculated
directly from BEP.

The basic DQM calibration process is described in the following steps and illustrated in Figure 295.

1. Input corrupted data (with clock)

Extract the frame sync word

Measure the BER of payload data

Compare DQM (converted to BEP) to measured BER and record/store on a packet by packet basis

wok we

Post process BEP and BER to develop score

Receiver Analyzer
Analyzer Saction

4 Ha - BEFBER
s . [l . Comsator
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Figure 295: DQM Calibration Fixture Process

Payload data is a user selectable length with a default of 4096 bits, unless block decoding is in use. In STC mode,
the default is 3200 bits. In SOQPSK/LDPC or STC/LDPC mode, the default is the selected LDPC block size. When
Reed-Solomon decoding is enabled, the default is 1024 bits.

With a payload data length of 4096 bits, the network bandwidth expansion is ~1%.
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DQM accuracy may be verified under various channel impairments including AWGN-static level, AWGN-dynamic
level (step response), dropouts, in-band and adjacent channel interference, phase noise, timing jitter, static multipath,
and dynamic multipath (similar to break frequency).

11.1 RA BER vs. BEP Measurement Display

As noted above, interoperability of DQE from various equipment manufacturers requires that all adhere to the IRIG
standard. Also, DQM values must be accurate estimates of actual bit error probability, or source selectors will suffer
degraded performance. Therefore, the ability to verify DQE conformance and DQM accuracy is critical.

The RA BEP/BER Correlator is a powerful tool for measuring DQM accuracy. It works by accumulating actual
error counts and estimated error counts for every DQM value received. The comparison of these indicates DQM
accuracy.

DQM values have a very fine level of granularity, with 65,536 possible values representing BEPs from 0.5 to le-12.
Accumulating statistics for each individual DQM value might take a very large amount of test time. To accelerate
testing, the 65,536 possible DQM values are grouped into 256 bins, each containing 256 successive DQM values.
The resulting bins still have good granularity, representing BEP steps of approximately 1.1x (e.g., one bin represents
a BEP of 1.0e-6, and the next bit represents a BEP of 1.1e-6).

Each bin has three pieces of information associated with it:

e A count of bits from all DQE frames with DQM value in the bin
e A count of errors from all DQE frames with DQM value in the bin
e The average BEP represented by the 256 DQM values in the bin

For each DQE frame received, the RA counts the number of bits and the number of bit errors, then adds those to a
running total for the bin associated with the DQM value in the frame.

At the end of the measurement, each bin has a count of the total bits and the total bit errors that occurred in that bin.
The ratio of these counts (errors/total) is the measured BER for each bin, which can be compared with the BEP
associated with that bin.

The data is plotted in two ways:

e  The count of bits and bit errors for each bin, as shown in Figure 296
e The calculated BER for each bin, as shown in Figure 297

In these instances, the x axis is the BEP associated with each bin—BEP (Derived from DQM).
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In Figure 296, the dark blue dots show the total count of bits in each bin, generally ranging between 4,000 and

Figure 296: Count of Bits and Bit Errors in Each Bin

20,000,000 in this example. The three peaks correspond to three AWGN step levels.

The light blue dots show the total count of bit errors in each bin, ranging from 2 to 600,000, in this example (Figure

296).
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Figure 297: Calculated BER in Each Bin (Bits/Errors)

In Figure 297, the blue dots show the calculated bit error rate (BER) in each bin, ranging from 7e-6 to 6e-2 (dividing
error count by the total count from Figure 296).

The error bars indicate the 95% confidence level for the actual BER if the measurement could run infinitely long and
are large, where the count of bit errors is small.

The grey line shows the ideal result (BER = BEP). Deviation from the ideal result indicates suboptimal DQM
estimation. The amount of deviation is a direct indicator of the potential degradation of BSS performance. At low
BEP, a few outlier points may appear due to insufficient error counts for reliable statistics; these should have large
error bars and are expected and normal. However, no points should lie on the y axis.
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12 Appendix C — Firmware Updates

12.1 RA 3.0 Firmware Update

The RA hardware contains an Altera FPGA with embedded microprocessor. Each requires its own firmware to
operate the RA. RxAn requires a specific version of firmware. If the firmware in the RA hardware does not match
the version required by RxAn, a warning is displayed, as shown in the tan banner at the bottom of Figure 298.

Figure 298: RxAn GUI Incompatible Firmware Warning Banner

If the firmware version is not compatible, the system still operates as best it can, but there may be unexpected errors.

The required version of firmware is embedded in the RxAn executable and can update the RA firmware, however
RxAn requires a set of programming tools from Altera. These tools are available at:

https://downloads.intel.com/akdlm/software/acdsinst/17.0/290/ib_installers/QuartusProProgrammerSetup-
17.0.0.290-windows.exe

This will download the Standalone Quartus Tools installer, as shown in Figure 299. When the download is
complete, execute the file and follow the prompts. It is best to use the default options.
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Figure 299: Download Quartus Tools Installer

To update the RA firmware, use the RxAn GUI Tools Menu on the Menu Bar (a), OR the Warning Banner (b).

a. Select Tools -> Firmware -> Update:

Tools | Window Help
RA Configuration L |

| Firmware ] | | Update
Calibration ] sl
Propertias ]
Logs ]
APl Server L
Plugins ]

Figure 300: Main Menu, Tools, Firmware > Update Selection

b. Click on the version tan Warning Banner:
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Figure 301: RxAn GUI Tan Warning Banner

Option a) and b) display the RA Firmware Update dialog box, shown in Figure 302.
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Figure 302: RA Firmware Update Dialog Box
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If the Altera programming tools have not been installed, the RA Firmware Update dialog box displays an error, as
shown in Figure 303.
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Figure 303: RA Firmware Update Dialog Box Programming Tools Not Found Message

12.1.1 Update Firmware
The Update Firmware dialog box has the following sections:

e Tools

e Files
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e (ables

e Firmware Revision
e  Messages

e  Action Buttons

e  Status

12.1.1.1 Tools

The Tools section, highlighted in Figure 304, shows the paths to the two executables RxAn uses to update the RA
firmware. If the executable files were found, a green checkmark displays to the left of each file.
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Figure 304: RA Firmware Update Dialog Box, Tools Section
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The user may also manually select the executable files by clicking on the Browse button, shown in Figure 305.

&
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Figure 305: RA Firmware Update Dialog Box, Tools Section, Browse Button

12.1.1.2 Files

The Files section, highlighted in Figure 306, shows the paths to the firmware update images (EIf/SOF), an override
file (used to tell the Altera tools what it is programming), and a folder to place the backup firmware images.
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Figure 306: RA Firmware Update Dialog Box, Files Section
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The user may also manually select the update files or select an alternate backup location by clicking on the Browse
button, as highlighted in Figure 307.

Files l
J EIf File; |E:kUsersf-;};qﬂ;,L'?_-*.'f;\..quasunix‘xF;nrmarE\ra.elﬁﬂash
v SOF File: [ C:\Users\ i 54 A quascnix\Firmware\ra.sof flash
J Cwerride File: EC:\Usm\}}i‘ﬂ;ﬁ@'ﬁh{;umrﬁx\Hnmvare\NESCmﬁdA.b:t
J Backup Folder: |C\Users\ ki

Figure 307: RA Firmware Update Dialog Box, Files Section, Browse Button

By default, the SOF (FPGA) and Elf (microprocessor) firmware are updated. The user can control which are updated
using the check boxes next to the SOF and Elf files, as shown in Figure 308.

Files
J Elf Fila: ?C:‘\Users"-;ga,-_c};'?;;.'qt;"\*quascmix‘.ﬁnrmare‘\ra.e[’r’.ﬂash |__-_.__|
v SOF File: [¥] C:\Users\ i =4 \.quasonix\Firmware\ra sof flash L]
W/ Override File: |CAUsers\ii i, quasonis\Firmware\N25Q064A. bt [..]

(]

J Backup Folder: iC:";Usm\E.?.'.;?-‘.ﬁ-

Figure 308: RA Firmware Update Dialog Box, Files Section, Update Selection Check Boxes

The Rescan button, highlighted in Figure 309, directs RxAn to attempt to find these files/locations again if there has
been an error, or the user wants to return to the default files.

Figure 309: RA Firmware Update Dialog Box, Files, Rescan Button
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12.1.1.3 Cables

Inside the RA is a JTAG programming cable that is used by the Altera tools to program the firmware updates. Each
RA has one JTAG cable, as highlighted in Figure 310. If you have multiple RAs attached to your PC, multiple
JTAG cables will be found. RxAn populates the JTAG Cable drop down menu with a list of JTAG cables it finds.
The user may select which cable to use.
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Figure 310: RA Firmware Update Dialog Box, Cables Section

The Rescan button, highlighted in Figure 311, directs RxAn to rescan for JTAG cables.
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Figure 311: RA Firmware Update Dialog Box, Cables, Rescan Button

12.1.1.4 Firmware Revision
The Firmware Revision, highlighted in Figure 312, shows the revision of the firmware to be programmed.

Cables
J JTAG Cable: | USB-Elasterll [USB-3] {5CE[BAT|FAT|FATES))

Firmware Revision: 3.1.0.1

Figure 312: RA Firmware Update Dialog Box, Firmware Revision

12.1.1.5 Messages

The Message section, shown in Figure 313, displays various messages generated during the Firmware Update
process. The messages can be saved to a file using the Save button, copied to the clipboard using the Copy button, or

cleared, using the Clear button.
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Figure 313: RA Firmware Update Dialog Box, Message Section

12.1.1.6 Action Buttons

The Action buttons, highlighted in Figure 314, allow the user to Update the firmware using the selected files, Revert
using a backup, Cancel an update in progress, or Close the Firmware Update dialog box.

Al Quasonix, Inc.
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Figure 314: RA Firmware Update Dialog Box, Action Buttons

12.1.1.6.1 Update Process

After the Update button is clicked, the firmware update process starts by extracting the entire contents of the RA
firmware and storing it in the folder specified by the Backup Folder parameter in the Files section. The filename is
based on the RA serial number, the major, minor, revision, and build number, and a date/time stamp. This helps
ensure that no firmware backup file is inadvertently overwritten.

The SOF (if enabled) and EIf (if enabled) files are loaded and combined into a single image for programming.

The combined image is programmed into the RA. Any stored parameters in the RA are erased to ensure the new
firmware is starting from a default configuration.

The entire contents of the RA firmware is then extracted again, and a new backup is created in the backup folder.
This allows the user to swap between any older versions of firmware if needed.

At the end of the update a final message displays, as shown in Figure 315.
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Figure 315: RxAn Firmware Update Messages

12.1.1.6.2 Revert

The Revert button allows the user to restore any of the backup files. An Open window, shown in Figure, provides a
list of available backups. Select the backup file, then click on the Open button to immediately start the revert.
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Figure 316: Revert, Open File

12.1.1.6.3 Status
A Status Bar is located at the bottom of the RA Firmware Update dialog box, as shown in Figure 317.

Figure 317: RA Firmware Update Dialog Box, Status Bar

12.2 Upgrading from an RA2.0 to an RA3.0

When upgrading from an RA2.0 to an RA3.0, the first step must be a firmware update. While RxAn can update the
RA2.0 firmware, it cannot communicate with an RA running RA2.0 firmware.
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13 Appendix D — API Server

RxAn can host a REST API server. For detailed information about how to use the API server, refer to the Receiver
Analyzer API Server User Manual (not yet available).

13.1 Start API Server From Shortcut

The API server can automatically be started when RxAn starts by specifying either -api or --apiserver on the
command line. A shortcut can be created to RxAn to add command line options.

1. Open the RxAn installation folder (defaults to C:\Program Files\Quasonix\RxAn).

2. Create a link to RxAn.exe, as shown in Figure 318.
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Figure 318: Create Link to RxAn.exe

The created shortcut icon and the location it points to are shown in Figure 319.
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Figure 319: RxAn.exe Shortcut Created to Location Shown

3. Right click on the shortcut icon, then select Properties from the menu, as shown in Figure 320.
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Figure 320: Shortcut Menu, Properties Selected

The shortcut properties dialog box is shown in Figure 321.
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Figure 321: Shortcut Properties Dialog Box

4. In the Target field, add -api or --apiserver to the end of the line. Include the dashes, as shown in Figure 322.
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Figure 322: Shortcut Properties, Target Field with Added -api

5. Click on the OK button, as shown in Figure 323. When RxAn is started using this shortcut, the API Server
is also started.
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Figure 323: Shortcut Properties, OK Button Starts API Server

13.2 Start API Server From RxAn Tools Menu

The API server can be started, restarted, or stopped from the Tools > API Server menu, as shown in Figure 324.
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Figure 324: Start/Restart/Stop API Server Using Tools > API Server Menu

The status of the API server is available through Tools > API Server > Status option, as shown in Figure 325.
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Figure 325: RxAn Tools > API Server >Status

The status is either Stopped or Running, as shown in Figure 326 and Figure 327. If the API Server status is Running,
the URLs field is populated with the IP addresses the API server responds to. By default, the IP address is the IP
address of the machine RxAn is running on. This is indicated by http://[::]:80.
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Figure 326: API Server Stopped Figure 327: API Server Running
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14 Appendix E — Acronym List

Acronym Description
AM Amplitude Modulation
AQPSK Asymmetric (1/Q bit rates) Quadrature Phase Shift Keying
ARTM Advanced Range Telemetry
ASM Attached Sync Marker
AUQPSK érs]);r:emse:;ifct: P((I/eCyJIrl?lgt rates) Unbalanced (I/Q power) Quadrature
AWGN Additive White Gaussian Noise
BEP Bit Error Probability
BER Bit Error Rate
BNC Bayonet Neill-Concelman Connector (RF Connector)
BPSK Binary Phase Shift Keying
CPM Continuous Phase Modulation
dBm Decibe_ls referenced to one milliwatt; A 0 dBm signal is equal
to 1 milliwatt
DPM Digital Phase Modulation
DQE Data Quality Encapsulation
DQM Data Quality Metric
Eb/NO Engrgy per bit divided by noise; normalized signal-to-noise
ratio
FEC Forward Error Correction
IF Intermediate Frequency
kHz Kilohertz
LDPC Low Density Parity Check
Mbps Megabits per second
MHCPM multi-h Continuous Phase Modulation
MHz Megahertz
OQPSK Offset Quadrature Phase Shift Keying
PCM/FM Pulse Code Modulation/Frequency Modulation
PM Phase Modulation
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Acronym Description
PSK Phase Shift Keying
QPSK Quadrature Phase Shift Keying
RA Receiver Analyzer
RF Radio Frequency
RM Rack Mount
RxAn Receiver Analyzer Graphical User Interface
SOQPSK Shaped Offset Quadrature Phase Shift Keying
TTL Transistor Logic
UQPSK Unbalanced (I/Q power) Quadrature Phase Shift Keying
USB Universal Serial Bus
VAC Volts Alternating Current
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